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Introduction: Manual Information
Manual Information

Revision History

The document number and revision appear at the bottom of each page. The following table 
outlines the manual’s revision history.

Manual Purpose

This manual provides technical information to service and technical personnel so they can 
install and maintain the equipment. Use it as a guide for maintenance and electrical repairs 
considered field repairable. Where necessary the manual identifies additional sources of 
relevant information and or technical assistance.

See the operator manual for the instructions necessary to operate the equipment safely in 
accordance with its function and intended use.

MARS Hardware and Operating Systems

Currently, MARS™ Holter Analysis Systems v7 shipped from GE Healthcare are loaded with 
Windows XP or Windows 2003 server software.

Table 1. Revision History 2020044-065

Revision Date Comment

A 17 May 2005 Initial release of this manual.

B 7 July 2005  Added “Security Updates” on page 1-12.
 Added Warning statement to use Medical Grade 

UPS when SEER Light Connect is used with the 
MARS™ Holter Analysis System. Refer to 
“Uninterruptible Power Supply (UPS)” on 
page 2-33.

 Various clarifications.

C 24 February 2006  Added information for dc7600 hardware.
 Various clarifications.

D 1 May 2006 Updated for 19" LCD1990SXi flat panel display

E 30 March 2007  Updated for the HP dc5750 platform.
 Update “Security Updates” on page 1-12

F 19 September 2008 Added information about the HP rp5700 client, HP 
L1910 LCD display, and HP 4015N LaserJet printer. 

G 27 October 2008 Revised the system activation procedure. 

H 22 April 2009 Added information regarding new modem.

J 25 February 2013 Added information regarding new monitor.
Added HP rp5800 server and workstation.
Added Powervar ABC MED isolation transformer.
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Introduction: Manual Information
This manual primarily covers the MARS™ Holter Analysis Systems running the Windows 
2000 operating system. These systems run on a Compaq Evo D510, Hewlett Packard (HP) 
D530 CMT, HP dc7100 CMT, HP dc7600 CMT, or an HP dc5750 system.

The MARS™ Holter Analysis Systems running the Windows NT operating systems are only 
discussed in two chapters, the “Network Setup” on page 3-1, and the “System Rebuild” on 
page 6-1. For any additional information on the MARS Holter Analysis systems running 
Windows NT, see the original Service Manual that shipped with that particular unit.

MARS™ Holter Analysis Systems can also run on Windows 2003 server, and XP operating 
systems. These operating systems are briefly covered in this manual. See the MARS™ 
Holter Analysis System Pre-Installation Guide, and the MARS™ Holter Analysis System 
Installation and Troubleshooting Guide, for additional information regarding installing and 
updating software on these operating systems.

Typographical Conventions 

The following typographical conventions are used in this document. 

Manual Content

This manual is organized into the following chapters.

 Chapter 1, “Introduction” 

Describes the service manual and chapter contents. Provides general 
information on safety, service requirements, equipment symbols, and 
serial number identification.

 Chapter 2, “Equipment Overview and System Setup” 

Describes the equipment and its technical characteristics, preparation 
for use, and connector locations. An interconnect table is provided for 
setting up and connecting the system.

 Chapter 3, “Network Setup” 

Describes network installation for the Windows NT and Windows 2000 
systems, the process for adding new users to the workgroup, and how to 
change from a workgroup to a domain.

Convention Description

Bold Indicates keys on the keyboard, text to be entered, or hardware 
items such as equipment buttons or switches. 

Italics Indicates software terms such as menu items, buttons, field 
names, or options. 

[Key 1] + [Key 2] Indicates a sequence of keys that must be pressed to initiate an 
action. While pressing and holding the first key, press and release 
the second key. 

[Space] Indicates the spacebar must be pressed. Used in command line 
instructions when the command must be entered precisely. 

Enter Indicates the Enter or Return key must be pressed. 
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 Chapter 4, “Maintenance” 

Contains a preventive maintenance schedule, cleaning guidelines and 
checkout procedures. 

 Chapter 5, “Troubleshooting” 

Provides overall and specific troubleshooting help.

 Chapter 6, “System Rebuild” 

Provides instructions on rebuilding the MARS™ Holter Analysis System 
with an image disk. Also provides information on the reinstallation of 
MARS Holter Analysis application software.

 Chapter 7, “System Checkout” 

Provides a list of GE Healthcare and original equipment manufacturer 
(OEM) part numbers for field replaceable units (FRUs).

 Chapter 8, “Parts List” 

Provides instructions for verifying the correct installation and network 
configuration of the MARS™ Holter Analysis System system.

 Appendix A, “Appendix A – Technical Descriptions” 

Includes technical specifications.

 Appendix B, “Appendix B – Configuring Patient Slots” 

Includes slot configuration information.

 Appendix C, “Appendix C – Electromagnetic Compatibility” 

Includes electromagnetic compatibility (EMC) declaration.

Related Documents

Additional information can be found in the following documents: 

Part Number Title

2020044-063 MARS™ Holter Analysis System Operators Manual

2020044-064 MARS™ Holter Analysis System Installation and Troubleshooting 
Guide

2020044-067 T-Wave Alternans Physician’s Guide

2020044-068 Adding MAR™ to MUSE Communication

2020044-069 MARS™ Holter Analysis System Pre-Installation Guide

2020044-105 Heart Rate Turbulence Physician’s Guide
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OEM Documentation and Support

The following table lists the system components provided by each original equipment 
manufacturer (OEM) and the URL of each component’s support page. The support pages 
provide the most current component information, drivers, manuals, troubleshooting help, and 
support forum. The URLs were current and active at the time this manual was released but 
are subject to change without notice.

Requirements for accessing and viewing these additional documents vary from manufacturer 
to manufacturer and sometimes from product to product. Please refer to the requirements 
listed on each OEM’s website.

Table 2. OEM Component Support Pages

Component 
Type

Component Support Page

Workstations HP rp5700 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=3375897&lan
g=en&cc=us

HP rp5750 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=3252512&sub
mit.y=8&submit.x=6&lang=en&cc=us

HP rp5800 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=5081352&exit
=product_series_oid&jumpid=reg_r1002_usen_s-
001_title_r0001%#29=en&cc=us

HP rp7600 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=472277&lang
=en&cc=us

HP dc7100 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=410112&lang
=en&cc=us
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Printers HP LaserJet P4015N http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=3558793&sub
mit.y=0&submit.x=0&lang=en&cc=us

HP LaserJet P4250 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=412144&lang
=en&cc=us

HP LaserJet 4200N http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=84028&lang=
en&cc=us

HP LaserJet 1200 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=29789&lang=
en&cc=us

Ricoh Aficio SP4100N http://www.ricoh-usa.com/products/
product_features.asp?pCategoryId=25&pCatName=Printers&tsn=Ricoh-
USA&pSubCategoryId=20&pSubCatName=Printers%20-
%20Monochrome%20Laser&pProductId=774&pProductName=Aficio%20SP
%204100N

Monitors HP L1910 19-inch LCD http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=382087&prodSeriesId=3561416&su
bmit.y=0&submit.x=0&lang=en&cc=us

HP LE1911 19-inch LCD http://h20000.www2.hp.com/bizsupport/TechSupport/
Document.jsp?lang=en&cc=us&objectID=c01922882&prodTypeId=382087&
prodSeriesId=3561416

Compaq CV7500 17-inch CRT http://h10025.www1.hp.com/ewfrf/wc/
product?product=313889&lc=en&cc=us&dlc=en&submit.y=8&submit.x=7&la
ng=en&cc=us

NEC 1990SXi 19-inch LCD http://www.necdisplay.com/SupportCenter/Product/?product=bb77b527-
6721-4721-b36c-f0b961836afb

Sony CPD-G520P http://esupport.sony.com/US/perl/model-home.pl?mdl=CPDG520P&LOC=3

NEC LCD 1850X http://www.necdisplay.com/SupportCenter/Archive/

NEC LCD 1990SXi http://www.necdisplay.com/SupportCenter/Archive/

Modems Multitech MultimodemZBA http://multitech.com/PRODUCTS/Families/MultiModemZBA/

UPS Powerware 5115 http://www.powerware.com/UPS/5115_UPS.asp?cx=3

Table 2. OEM Component Support Pages

Component 
Type

Component Support Page
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Safety Information

Responsibility of the Manufacturer

GE Healthcare is responsible for the effects of safety, reliability, and 
performance only if:

 Assembly operations, extensions, readjustments, modifications, or 
repairs are carried out by persons authorized by GE Healthcare.

 The electrical installation of the relevant room complies with the 
requirements of the appropriate regulations.

 The equipment is used in accordance with the instructions for use.

NOTE
The addition of non-approved software programs and network devices 
are not recommended or supported by GE Healthcare. Repairs or 
Technical Support assistance for failures related to non-approved 
applications and configurations are not covered by warranty, and will be 
charged on a time and material basis.

General

This device is intended for use under the direct supervision of a licensed health care 
practitioner.

To ensure patient safety, use only parts and accessories manufactured or recommended by 
GE Healthcare.

Contact GE Healthcare for information before connecting any devices to this equipment that 
are not recommended in this manual.

If the installation of this equipment, in the USA, will use 240 V rather than 120 V, the source 
must be a center-tapped, 240 V, single-phase circuit.

Parts and accessories used must meet the requirements of the applicable IEC 601 series 
safety standards, and/or the system configuration must meet the requirements of the IEC 
601-1-1 medical electrical systems standard.

The use of ACCESSORY equipment not complying with the equivalent safety requirements 
of this equipment may lead to a reduced level of safety of the resulting system. Consideration 
relating to the choice shall include:

 use of the accessory in the PATIENT VICINITY; and

 evidence that the safety certification of the ACCESSORY has been 
performed in accordance to the appropriate IEC 601-1 and/or IEC 601-
1-1 harmonized national standard.

Information Technology Equipment

The hardware components that make up the MARS™ Holter Analysis System are considered 
to be Information Technology Equipment (ITE). These individual components have been 
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found to comply with the standard for Safety of Information Technology Equipment, Including 
Electrical Business Equipment EN60950 (UL 950).

The software used in the MARS™ Holter Analysis System is considered as medical software. 
The software has been designed and manufactured to the appropriate medical regulations 
and controls.

The MARS™ Holter Analysis System, which consists of the hardware and software 
components together, is considered a medical device. However, the appropriateness of 
applying the ITE requirements to evaluate the hardware portions of the workstation can be 
justified by the fact that the MARS™ Holter Analysis System does not have any applied parts 
nor is the MARS™ Holter Analysis System intended for use in the “patient environment”.

Equipment Symbols

The following symbols may appear on the equipment. For equipment symbols not shown 
refer to the original manufacturer’s equipment manuals. 

WEEE Symbol

This symbol indicates that the waste of electrical and electronic 
equipment must not be disposed as unsorted municipal waste and 
must be collected separately. Please contact an authorized 
representative of the manufacturer for information concerning the 
decommissioning of your equipment.

Date of Manufacture

The number found under this symbol is the date of manufacture in the 
YYYY-MM format.

Monitors

Sets monitor brightness

Sets Monitor Contrast

Power button

Disk Drive LEDs

Indicates disk activity (flashing green)

Indicates disk is on-line (green)
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Safety Messages

The following terms are used throughout this manual to alert the reader to important 
messages regarding the safe use of the product. 

 DANGER 

Indicates an imminently hazardous situation which, if not avoided, WILL 
result in death or serious injury.

 WARNING 

Indicates a potentially hazardous situation which, if not avoided, COULD 
result in death or serious injury.

 CAUTION 

Indicates a potentially hazardous situation which, if not avoided may 
result in minor or moderate injury.

 NOTE 

Provides additional user information.

Indicates a disk failure (amber)

UPS

Identifies the row of LEDs that show AC input level

Identifies the row of LEDs that indicate battery charge Level

Identifies the row of LEDs that indicate load devices

Power ON button
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Warnings and Cautions

The following messages apply to the product as a whole. Specific messages may also appear 
elsewhere in the manual. 

DANGER
Do NOT use in the presence of flammable anesthetics.

WARNINGS
Replace only with the same type and rating of fuse.

This is Class I equipment. The mains plug must be 
connected to an appropriate power supply.

Turn off power and disconnect power cord from AC power 
source before removing the cover.

CAUTIONS
To reduce the risk of electric shock, do NOT remove cover 
(or back). Refer servicing to qualified personnel.

This equipment contains no user serviceable parts. Refer 
servicing to qualified service personnel.

DO NOT load any software other than that specified by GE 
Healthcare onto the MARS™ Holter Analysis System. 
Installation of software not specified by GE Healthcare may 
cause damage to the equipment or loss or corruption of 
data.

U.S. Federal law restricts this device to sale by or on the 
order of a physician.
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Service Information

Service Requirements

Refer equipment servicing to GE Healthcare authorized service personnel only. Any 
unauthorized attempt to repair equipment under warranty voids that warranty.

It is the user’s responsibility to report the need for service to GE Healthcare or to one of their 
authorized agents.

Failure on the part of the responsible individual, hospital, or institution using this equipment to 
implement a satisfactory maintenance schedule may cause undue equipment failure and 
possible health hazards.

Regular maintenance, irrespective of usage, is essential to ensure that the MARS Holter 
Analysis Standalone, Client and Server will always be functional when required.

Security Updates

A list of viruses that pose a significant threat to GE customers’ product 
security are posted on the GE Healthcare Product Security Database web 
site. Vulnerability notification to customers will occur through the website. 
After security patches have been validated for specific GE Healthcare 
products, this information will be added to this database. After confirming 
that a particular security patch has been validated for your system 
configuration, you can download it directly from the web site of the software 
manufacturer (Microsoft, etc.) and applied to the customer’s GE product. To 
check on the latest information regarding validated security patches:

1. Browse to the GE Healthcare Product Security Database web site:

http://www.gehealthcare.com/usen/index.html

2. Select Product Security from the Solutions drop-down list.

3. Select Product Vulnerability Database.

4. Login with your SSO (Single Sign On) username and password.

NOTE
If you do not have an SSO, click the Sign Up link to obtain an SSO.

Use the features on the GE Healthcare Product Security Database web site to determine 
security patches that can be applied to your system.
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Product Code Identification

The Product Code is used to identify specific system platforms. Using the Product Code 
Table below and before servicing the MARS™ Holter Analysis System, identify the correct 
product code of the system.

The product code can be identified using the serial number listed on the product label 
attached to the base of the system. In newer systems, the serial number is located in the 
About window. Launch the MARS application (see “Power On Procedure” on page 4-4) and 
click Help > About to view the serial number. See “Equipment Identification” on page 1-15 for 
serial number formats and descriptions.

Table 3. Product Codes 

Product Code 
or catalog 

number 
MARS Model Operating System

PU MARS Holter Analysis 
Standalone and Client 

Microsoft Windows NT Service 
Pack 6A (manufactured in USA)

2006542-002 MARS Holter Analysis 
Standalone and Client 

Microsoft Windows NT Service 
Pack 6A (manufactured in 
Germany)

HY MARS Holter Analysis 
Standalone and Client 
workstation (Compaq Model Evo 
D510) 

Microsoft Windows 2000 
Professional Service Pack 3

MARS Holter Analysis 
Standalone and Client 
workstation (HP Model EVO 
D530) 

Microsoft Windows 2000 
Professional Service Pack 4

HY MARS Holter Analysis Server 
(Compaq Model D510) 

Microsoft Windows 2000 Server 
Service Pack 3

MARS Holter Analysis Server 
(HP Model EVO D530) 

Microsoft Windows 2000 Server 
Service Pack 4
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SAT MARS Holter Analysis 
Standalone and Client 
workstation (HP Model dc7100) 

Microsoft Windows 2000 
Professional Service Pack 4

MARS Holter Analysis Server 
(HP Model dc7100)

Microsoft Windows 2000 Server 
Service Pack 4

MARS Holter Analysis 
Standalone and Client 
workstation (HP Model dc7600) 

Microsoft Windows XP 
Professional Service Pack 2

MARS Holter Analysis Server 
(HP Model dc7600)

Microsoft Windows 2003 Server 
Service Pack 1

MARS Holter Analysis 
Standalone and Client 
workstation (HP Model dc5750) 

Microsoft Windows XP 
Professional Service Pack 2

MARS Holter Analysis Server 
(HP Model dc5750)

Microsoft Windows 2003 Server 
Service Pack 2

MARS Holter Analysis 
Standalone and Client 
workstation (HP model RP5700)

Microsoft Windows XP 
Professional SP3 

MARS Holter Analysis Server 
(HP model RP5700)

Microsoft Windows Server 2003 
R2 SP2 

SKC MARS Ambulatory ECG 
Standalone
and Client Workstation
(HP model rp5800)

Microsoft Windows XP 
Professional
Service Pack 3

SA2 MARS Software-only USB 
Dongle

Microsoft Windows 2000 Server
Microsoft Windows 2000 Pro
Microsoft Windows XP Pro
Microsoft Windows 2003 Server

AB8 MARS Software-only Parallel 
Dongle

Microsoft Windows NT
Microsoft Windows NT Server
Microsoft Windows 2000 Server
Microsoft Windows 2000 Pro
Microsoft Windows XP Pro
Microsoft Windows 2003 Server

Table 3. Product Codes (Continued)

Product Code 
or catalog 

number 
MARS Model Operating System
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Equipment Identification

Every GE Healthcare device has a unique serial number for identification. The serial number 
appears on the device label and may appear in one of two formats.

Format A is shown in the following illustration

   

Table 4. Equipment Identification 

Item Name Description

A name of device MARS™ Holter Analysis System

B manufacturer GE Healthcare

C serial number Unique identifier

D device characteristics One or two letters that further describe the unit, for 
example: P = prototype not conforming to 
marketing specification; R = refurbished 
equipment; S = special product documented under 
Specials part numbers; U = upgraded unit

E division F = Cardiology        G = Monitoring       N = 
Freiburg Hellige

F product sequence 
number

Manufacturing number (of total units manufactured)

G product code Two-character product descriptor 
PU = MARS™ Holter Analysis System 

H year manufactured 0 = 2000, 1 = 2001, 2 = 2002, (and so on)

I month manufactured A = January, B = February, C = March, D = April, E 
= May, F = June, G = July, 
H = August, J = September, K = October, L = 
November, M = December

MD1113-022C

C

B

A

H
G F

E
DI
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Format B is shown in the following illustration.

A Product Code

B Year Manufactured (00-99)
00 = 2000
04 = 2004
05 = 2005
(and so on)

C Fiscal Week Manufactured

D Production Sequence Number

E Manufacturing Site

F Miscellaneous Characteristic

### ## ## #### # #

A B C D E F
1-16 MARS™ Holter Analysis System 2020044-065J



2 Equipment Overview 
and System Setup
2020044-065J MARS™ Holter Analysis System 2-1



For your notes
2-2 MARS™ Holter Analysis System 2020044-065J



Equipment Overview and System Setup: System Characteristics
System Characteristics

General Description

The MARS™ Holter Analysis System is a multi-parameter analysis and review system on a 
platform that supports the MARS Holter analysis and editing system software.

NOTE
The picture is a representative system. Your system configuration may 
vary. The printer, modem, and power supply are not pictured.

Hardware

The MARS Holter Analysis server, client, and standalone workstation use an Intel PC 
platform with the Microsoft Windows operating system. This multi-tasking environment 
provides the ability to acquire, analyze, edit, and print simultaneously.

Peripherals include monitor, keyboard, mouse, card reader, printer, uninterruptible power 
supply (UPS) or isolation transformer, and an optical drive. The system also includes an 
analog modem for remote system support (RSS). A tape acquisition unit and external USB or 
parallel OMNI Drive are optional.

Storage requirements depend on the platform: 

03A

Platform Patient Data Patient Reports

Client and Standalone 25GB 10GB

Server 60GB 15GB
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Software

The following software is approved for use on the MARS Holter Analysis system. The addition 
of non-approved software programs is not recommended or supported by GE Healthcare. 

MARS Holter Analysis and Editing System Software

The MARS Holter analysis and editing system software acquires ECG data 
from electronic ECG recorders. The software provides:

 multiple techniques of scanning for complex editing

 algorithm enhancement for more precise beat and noise detection

 up to 12 high-resolution trends simultaneously on one screen

 pre-configured standard final reports

 dual channel superimposition displayed at up to 240 times real-time

MARS Holter Analysis Client and Standalone Software

MARS Holter Analysis software can be installed on MARS Holter Analysis clients and 
standalone workstations running Windows NT 4.0 service pack 6A, Windows 2000 
Professional service pack 4 with the multi-language package operating system, or Windows 
XP Professional.

MARS Holter Analysis Server Software

MARS Holter Analysis software can be installed on a MARS Holter Analysis server running 
the Windows 2000 Server operating system with the multi-language package, or Windows 
2003 Server.

CardioSoft Software

The MARS Holter Analysis Software is fully compatible with CardioSoft. CardioSoft client 
software will operate on a MARS Holter Analysis client or standalone workstation. The MARS 
Holter Analysis server software and CardioSoft server software packages have been qualified 
to operate simultaneously on the same computer.

NOTE
CardioSoft Client software and CardioSoft Server cannot both be 
installed simultaneously on the MARS Holter Analysis Server.

Software Activators

A single application may contain various features. Depending on the features that were 
purchased, it may be necessary to use a MARS Holter Analysis System software activator to 
activate or use specific features. See the MARS™ Holter Analysis System operator’s manual 
for additional information on using software activators.
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Remote System Support (RSS) Access Unit

Each MARS™ Holter Analysis System uses a non-networked analog modem for Remote 
System Support (RSS). The RSS access unit allows GE Healthcare to maintain, and if 
necessary, diagnose and repair the software.
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Configuration Options

The MARS™ Holter Analysis System can be provided in the following configurations: 

Standalone Workstation

 The patient data is stored locally and saved patient reports can be sent 
to a MUSE server across a network. There is no access to patient data 
from other MARS systems. The standalone runs with Windows NT, 
Windows 2000 professional, or Windows XP professional software. See 
“MARS Hardware and Operating Systems” on page 1-3 for more 
information.

 The standalone can print to a network or parallel printer.

Server

 The patient data is stored on the MARS Holter Analysis server and can 
be accessed by MARS Holter Analysis clients. In the event of server 
failure, or interrupted connectivity, patient data acquired at the client will 
be stored locally on the client. The server may have a card reader or 
tape acquisition device if 5 or less clients are attached. The patient 
reports can also be sent to a MUSE server. The server runs with 
Windows 2000 or Windows 2003 server software. See “MARS Hardware 
and Operating Systems” on page 1-3 for more information.

 The server can support a maximum of 25 MARS Holter Analysis clients.

Client

 The client automatically sends patient data to the MARS Holter Analysis 
server, and has access to all patient data stored on the server. It has 
data acquisition devices attached. The patient reports can also be sent 
to a MUSE server. The client must have a MARS Holter Analysis server 
to operate. The client runs with Windows NT, Windows 2000 
professional, or Windows XP professional software. See “MARS 
Hardware and Operating Systems” on page 1-3 for more information.

 The client can print to a network or parallel printer.

NOTE
GE Service personnel must configure the MUSE server to enable the 
MARS™ Holter Analysis System to communicate with the MUSE server.

Installation Options

The MARS Holter Analysis allows a choice between a Custom Installation and a Typical 
Installation. It is important to understand the difference between the installations before you 
continue.
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Typical Installation

NOTE
If you want to change from a standalone configuration to a client 
configuration, you must perform the Custom Installation option.

The Typical Installation will keep the standalone configuration and will add networking 
capabilities. It will not prompt the user to select between a client or a standalone 
configuration. The Typical Installation does not make any changes to the MARS Holter 
Analysis application location, number of patient slots, or startup information. The Typical 
Installation leaves all the patient data in its current location and retains the System Setup 
information.

Custom Installation

The Custom Installation will prompt the user to select between a client or a standalone 
configuration. The Custom Installation will prompt the user to change the MARS Holter 
Analysis application location, number of patient slots, and startup information. The Custom 
Installation option will maintain the original patient data, even if the user changes the MARS 
application software from the current disk location. The System Setup information will be 
retained.

NOTE
You must have a MARS Holter Analysis server to use the MARS Holter 
Analysis client configuration.

MARS™ Holter Analysis Systems running Windows NT do not support 
the Tape Acquisition option.
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Block Diagram

The block diagram is a representative configuration of a MARS™ Holter Analysis System. 
There are too many possible configurations to show them all.

1A
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System Setup

Table 5, “Configuration Interconnections,” on page 2-11 instructs how the client-server and 
standalone workstation should be set up. Please refer to the supplied OEM manuals and the 
“System Components and Locations” on page 2-13 for additional information.

WARNINGS
Keep leakage current within acceptable limits when connecting 
auxiliary equipment to this device.

This is Class 1 equipment. The mains plug must be 
connected to an appropriate power supply. See the leakage 
current warning on page 2-33 for important UPS information

Connecting the Equipment

Connecting the equipment consists of:

 Connecting the applicable peripheral devices

 Booting MARS™ Holter Analysis System for the first time

 Setting up the network

 Complete the check out procedure

To connect the equipment, follow the configuration table provided on the following pages.

MARS Holter Analysis Interconnection Guide

Table 5, “Configuration Interconnections,” on page 2-11 provides the physical connections 
necessary for the MARS Holter Analysis standalone and client-server configurations. Once 
the physical connections are completed go to “Network Setup” on page 3-1 for setting up the 
network.

Setting the Correct Source Voltage

Confirm the MARS™ Holter Analysis System is configured to receive the correct source 
voltage (115V or 230V) for your geographical area.

Configure the dip switches on the UPS to receive the correct source voltage for your 
geographical area. Use the “User’s Guide” that shipped with the UPS for the correct dip 
switch configuration.

Setting the Correct Platform Voltage

The power supplies of some platforms are equipped with a voltage switch that allows the user 
to toggle the power supply between 115V and 230V. This is typically a red switch located 
near the voltage inlet connector, as seen in the following illustration. 
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Before connecting your system to a power source, verify whether the system has a voltage 
switch. 

If your system has a voltage switch, make sure the switch is set to the correct voltage for your 
geographical area. Failure to set the voltage switch to the proper input voltage may result in 
damage to the unit when connected to a power source. 

If your system does not have a voltage switch, no additional action is required: the power 
supply will automatically detect the power line voltage. 

Protecting Against Viruses

To protect the MARS™ Holter Analysis System from viruses, the appropriate antivirus 
software should be installed before connecting the system to the network. It is recommended 
that the customer turn on the antivirus software auto protect option, and keep the virus 
definitions current to avoid virus infections. Please discuss virus protection with the hospital 
Information Systems (IS) department before proceeding with the network installation of this 
equipment.

In addition to installing antivirus software, it is recommended that the customer limit drive 
share access for additional virus protection. This can be accomplished by changing the share 
permissions for the gemsit folder. It is recommended that permissions be set for individual 
users, rather than the entire MARSWORKGROUP or an entire domain. This will change the 
default factory setup.
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Configuration Connection Guide

The following table describes how each MARS component connects to the system. To 
identify each component’s connectors, refer to the diagrams located in “System Components 
and Locations” on page 2-13.

Table 5. Configuration Interconnections 

Connect From Connect To Comments/Instructions 

Medical Grade Isolation Transformer

WARNING: See the leakage current 
warning on page  2-33 for important 
UPS information.

MARS™ Holter Analysis System

(HP dc7600 CMT, HP dc5750 MT, or 
HP rp5700 only.)

Plug the workstation power cord into the isolation 
transformer. DO NOT plug the printer into the isolation 
transformer.

AC Power Outlet Plug the isolation transformer into the AC power wall 
outlet.

Uninterruptible Power Supply (UPS)

WARNING: See the leakage current 
warning on page  2-33 for important 
UPS information.

MARS™ Holter Analysis System

(All systems EXCEPT the HP 
dc7600 CMT, HP dc5750 MT, and 
HP rp5700.)

Connect the RS232 9-Pin cable from the UPS 
computer interface port to the Serial-1 connector on 
the MARS™ Holter Analysis System. DO NOT plug 
the printer into the isolation transformer.

AC Power Outlet Plug the UPS power cord into the AC power wall 
outlet.

RSS MultiModem MARS™ Holter Analysis System Connect the 9-pin, serial-2 workstation connector to 
the modem D connector.

AC Power Wall Outlet Ensure the RSS MultiModem is “OFF”. Plug the AC/ 
DC Power supply into the modem, and then to the AC 
power wall outlet.

Telephone RSS MutiModem Phone connector plugs into the 
base of the telephone (via RJ11 cable).

Wall Phone Jack Plug the other end of the RSS MutiModem Phone 
connector into the wall phone jack.

Tape Acquisition Unit MARS™ Holter Analysis System Note: This is an optional device.

Connect to the MARS Holter Analysis SCSI connector 
then plug the terminator connector into the top 
connector on the Tape Acquisition unit. 
See “Tape Acquisition Unit (Optional)” on page 2-29 
for additional information.

External Card Reader (USB) MARS™ Holter Analysis System Note: This is an optional device.

Connect the USB version to workstation’s USB port. 
Connect the parallel port version to the work station’s 
parallel port. 
.
See “External Card Reader – Omni Drive (Optional)” 
on page 2-30 for additional information.

External Card Reader (Parallel Port)
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After the physical connections are completed, go to “Network Setup” on page 3-1 for setting 
up the network.

Keyboard MARS™ Holter Analysis System Connect to top left corner USB connector. (Looking at 
the rear of the workstation)

Mouse MARS™ Holter Analysis System Connect to green connector on the workstation.

Printer MARS™ Holter Analysis System Connect to the Parallel 2 connector.

Note: DO NOT plug the printer into the UPS or 
isolation transformer. 

AC Power wall outlet Ensure the printer is configured for the main power 
(i.e. 115VAC or 220 VAC).
Ensure the printer is “OFF” before plugging the power 
cord into the AC wall outlet.

Monitor MARS™ Holter Analysis System Connect via 15-pin D video connector.

AC Power wall outlet Ensure the monitor is configured for the main power 
(i.e. 115VAC or 220 VAC).
Ensure the monitor is “OFF” before plugging the 
power cord into the AC Power wall outlet.

MARS™ Holter Analysis System UPS AC receptacle Plug the power cord from the workstation into the UPS 
AC receptacle.

Network connector (ethernet) Connect via the network cable. 
NOTE: The network is optional on Standalone units.

Security Key (USB) MARS Holter Analysis Workstation Connect the USB version to workstation’s USB port. 
Connect the parallel port version to the work station’s 
parallel port. Security Key (Parallel Port)

Table 5. Configuration Interconnections (Continued)

Connect From Connect To Comments/Instructions (Continued)
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System Components and Locations

MARS Holter Analysis Standalone, Client and Server Systems

Compaq EVO D510, Front View 

035A

D

035A

A

B

C

Table 6. MARS Holter Analysis System (Compaq EVO D510, Front View) 

Item Name Description

A Internal card reader Reads holter data from data cards (This will be black in color, not white as pictured)

B CD-RW Drive Reads and writes to CD-RW

C Floppy Drive Reads floppy disks 

D Power Button Turns system on or off. 
2020044-065J MARS™ Holter Analysis System 2-13



Equipment Overview and System Setup: System Components and Locations
Compaq EVO D510, Rear View 
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Table 7. MARS Holter Analysis System (Compaq EVO D510, Rear View) 

Item Name Description

A Mouse Connector Connects the mouse.

B Parallel 1 Connector Extra parallel connector (not currently used)

C Ethernet Connector Connects to network

D SCSI Connector Connects to the tape acquisition unit (optional device)

E Parallel 2 Connector Connects to the printer

F Serial 2 Connector Connects to RSS Modem

G Serial 3 Connector Extra serial connection (not currently used)

H Serial 4 Connector Extra serial connection (not currently used)

J USB Connectors Connects to the USB keyboard (use top left USB port for keyboard)

K Audio Connector Connects devices that supply sound

L Video Connector Connects to the monitor

M Serial 1 Connector Connects to the UPS
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N Keyboard Connector Connects to the keyboard

P Power Adapter Connects unit to power outlet

Q Voltage Select Switch Switches voltage from 115V to 230V 

Table 7. MARS Holter Analysis System (Compaq EVO D510, Rear View) (Continued)

Item Name Description
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HP EVO D530, Front View 
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Table 8. MARS Holter Analysis System (HP EVO D530, Front View) 

Item Name Description

A Internal card reader Reads holter data from data cards

B CD-RW Drive Reads and writes to CD-RW

C Power Button Turns system on or off. 

D Universal Serial Bus Connectors 2.0 Front USB connectors.

E Headphone Out Jack Provides sound for headphones.

F Microphone In Jack Not Used

G Floppy Drive Reads floppy disks 
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HP EVO D530, Rear View 
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Table 9. MARS Holter Analysis System (HP EVO D530, Rear View) 

Item Name Description

A Mouse Connector Connects the mouse.

B Parallel 1 Connector Extra parallel connector (not currently used)

C Ethernet Connector Connects to network

D SCSI Connector Connects to the tape acquisition unit (optional device)

E Parallel 2 Connector Connects to the printer

F Serial 3 Connector Extra serial connection (not currently used)

G Serial 4Connector Extra serial connection (not currently used)

H Audio Connector Connects devices that supply sound

J USB Connector Connects to the USB keyboard (use top left USB port for keyboard)

K Video Connector Connects to the monitor

L Serial 1 Connector Connects to the UPS

M Keyboard Connector Connects to the keyboard

N Serial Connector 2 Connects to RSS Modem
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P Power Adapter Connects unit to power outlet

Q Voltage Select Switch Switches voltage from 115V to 230V 

Table 9. MARS Holter Analysis System (HP EVO D530, Rear View) (Continued)

Item Name Description
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HP dc7100, Front View 
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Table 10. MARS Holter Analysis System (HP dc7100, Front View) 

Item Name Description

A DVD-RW Drive Reads and writes to DVD-RW and CD-RW

B Power Button Turns system on or off 

C Universal Serial Bus Connectors 2.0 Front USB connectors

D Headphone Out Jack Provides sound for headphones

E Microphone In Jack Not used

F Floppy Drive Reads floppy disks 
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HP dc7100, Rear View 
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Table 11. MARS Holter Analysis System (HP dc7100, Rear View) 

Item Name Description

A AC input connector Connects unit to power outlet (or UPS)

B Keyboard connector Connects to the keyboard (Purple)

C Mouse connector Connects the mouse (Green)

D Serial 1 connector Connects to the UPS

E Video connector Connects to the monitor

F Audio out connector Headphone/Speaker audio out (Blue)

G Audio in connector Line audio in (Green)

H Serial Connectors Extra serial connectors

I Parallel port Connects to parallel printer

J USB ports 1 – 4 Connects to the USB keyboard (use leftmost USB port for keyboard) and other USB devices

K Ethernet connector Connects to network (connection on the left)

L USB ports 5 – 6 Other USB devices can be connected to these ports

M SCSI connector Connects tape acquisition unit
2-20 MARS™ Holter Analysis System 2020044-065J



Equipment Overview and System Setup: System Components and Locations
HP dc7600, Front View 
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Table 12. MARS Holter Analysis System (HP dc7600, Front View) 

Item Name Description

A DVD-RW Drive Reads and writes to DVD-RW and CD-RW

B Power Button Turns system on or off 

C Universal Serial Bus Connectors 2.0 Front USB connectors

D Headphone Out Jack Provides sound for headphones

E Microphone In Jack Not used
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HP dc7600, Rear View 
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Table 13. MARS Holter Analysis System (HP dc7600, Rear View) 

Item Name Description

A AC input connector Connects unit to power outlet (or UPS)

B Keyboard connector Connects to the keyboard (Purple)

C Mouse connector Connects the mouse (Green)

D Serial 1 connector Connects to the UPS

E Video connector Connects to the monitor

F Audio out connector Headphone/Speaker audio out (Blue)

G Audio in connector Line audio in (Green)

H Serial Connectors Extra serial connector

I Parallel port Connects to parallel printer

J USB ports 1 – 4 Connects to the USB keyboard (use leftmost USB port for keyboard) and other USB devices

K Ethernet connector Connects to network (connection on the left)

L USB ports 5 – 6 Other USB devices can be connected to these ports
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HP dc5750, Front View 
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Table 14. MARS Holter Analysis System (HP dc5750, Front View) 

Item Name Description

A DVD-RW Drive Reads and writes to DVD-RW and CD-RW

B Power Button Turns system on or off 

C Microphone In Jack Not used

D Headphone Out Jack Provides sound for headphones

E Universal Serial Bus Connectors 2.0 Front USB connectors
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HP dc5750, Rear View 
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Table 15. MARS Holter Analysis System (HP dc5750, Rear View) 

Item Name Description

A AC input connector Connects unit to power outlet (or UPS)

B Voltage Select Switch Switches voltage from 115V to 230V 

C Audio in connector Line audio in (Green)

D Audio out connector Headphone/Speaker audio out (Blue)

E Ethernet connector Connects to network (connection on the left)

F USB ports Connects to the USB keyboard (use leftmost USB port for keyboard) and other USB devices

G Serial 1 connector Connects to the UPS

H VGA connector Connects to the monitor

I Parallel port Connects to parallel printer

J DVI Connector Connects to the monitor

K Mouse connector Connects the mouse (Green)

L Keyboard connector Connects to the keyboard (Purple)

M Serial 2 Connector Extra serial connector
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HP rp5700, Front View 

Table 16. HP rp5700, front view 

Item Name Description

A Optical Drive CD/DVD

B Power button Recessed power button

C LEDs Power and activity lights

D USB Ports 2 USB 2.0 ports with rubber cover

E Hard Drive Internal hard drive
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HP rp5700, Back View 

Table 17. rp5700 client, rear panel connectors 

Item Name Description

A Mains 240W 80 PLUS® – Active PFC power supply (no line switching required)

B Mouse port Plug in a PS/2 mouse

C Audio jacks Line in and line out audio jacks

D Keyboard port Plug in a PS/2 keyboard

E COM port RS232 serial COM1 port

F Parallel port Plug in a parallel printer

G VGA port Plug in a monitor

H COM port RS232 serial COM2 port

I USB ports 4 USB 2.0 ports

J LAN jack RJ-45 LAN jack

K Expansion slots 2 low-profile slots: left ADD2/SDVO slot, right PCI3-x1

L PCI slots 2 full-height PCI slots
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HP rp5800, Front View

Table 18. HP rp5800, front view 

Item Name Description

A Optical Drive 5.25–inch DVD–R/DVD–RW capable drive

B Power Light A steady green light indicates the system is powered on.
A flashing red light indicates there is a problem with the
system and displays a diagnostic code. Refer to the OEM’s
Maintenance and Service Guide to interpret the code.

C Power Button Dual state power button

D Hard Drive Light LED flashes when internal hard drive is being accessed

E NIC Link Light LED lights up to indicate a network connection.

F USB Ports 2 USB 2.0 ports behind a sliding cover

G NIC Activity Light LED flashes to indicate network activity.
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HP rp5800, Back View

Table 19. rp5800 client, rear panel connectors 

Item Name Description

A Powered USB Powered USB port, 24V

B LAN Port RJ-45 network connector

C Serial Connector COM1 serial port

D Mouse Connector PS/2 mouse connector (green)

E Audio Connector Line-in audio connector (blue)

F Mains Mains power cord connector

G Powered USB Powered USB ports, 12V

H
Cash Drawer Connector Similar in size and shape to standard modem jack.

To avoid damaging the computer, DO NOT attempt
plug a network or phone cable into the connector.

I Display/Port DVI display connector

J Serial Connector COM2 serial port

K USB Un-powered USB ports

L VGA Connector VGA display connector

M Keyboard Connector PS/2 keyboard connector (purple)

N Speaker connector Line-out speaker connector (green)
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Tape Acquisition Unit (Optional)
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Table 20. Tape Acquisition Unit 

Item Name Description

A power LED Indicates the operating status of the tape acquisition unit. It glows green when 
power is applied.

B tape drive opening Allows tapes to be inserted into the tape acquisition unit.

C tape motion indicator LED Indicates the motion of the tape drive. It glows green when the tape moves faster 
than 100 mm/sec. It glows red when the tape speed drops below 100 mm/sec.

D release lever Depressing ejects the tape from the tape drive opening. Lever must be closed to 
start rewind.

E mains AC power port Connects the tape acquisition unit to an external mains AC power source. The tape 
acquisition unit contains a 120v/240v autosensing power supply.

F power (On/Off) switch Controls the power to the tape acquisition unit.

G SCSI ID switch Selects the SCSI target ID number. SCSI target ID for connecting to workstation = 
5.

H cooling fan intake Moves air in to cool tape acquisition unit components.

J SCSI port Connects to the terminator connector

K SCSI port Connects to SCSI port on the back on the MARS™ Holter Analysis System
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External Card Reader – Omni Drive (Optional)

See “Card Reader – Omni Drive (Optional Device)” on page 5-12 for information on setting 
the drive letter.

006A

A

B

D
C

016A

External Card Reader – Omni Drive 

Item Name Description

A Power On Indicator Green LED is lit when power is on. (Power is applied through the USB cable.)

B Busy Indicator Red LED is lit when transferring data.

C Card Eject Button Push the button to eject the card.

D USB Connection Connect the USB cable to the port on back on the Omni Drive and to a USB port on the 
MARS™ Holter Analysis System.
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SEER Light Connect (Optional)
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Item Name Description

A data transfer cable Used to transfer data from the SEER Light recorder to the SEER Light Connect. 

B infrared terminal Used to communicate with the SEER Light recorder.

 Receives ECG waveform data from a SEER Light recorder to preview.
 Transfers patient demographics to the SEER Light recorder.
 Starts the SEER Light recorder.

C USB Connection Uses a USB patch cord to transfer data from the SEER Light Connect to the Holter analysis 
system.

D LED indicator  Flashes when data is transferring.
 Lights without flashing when a proper connection exists.
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Remote System Access Unit 

MultiTech MultiModem (MT9234ZBA)

Item Name Description

1 TD (Transmit Data) The TD LED flashes when the modem is transmitting data to another modem. 

2 RD (Receive Data) The RD LED flashes when the modem is receiving data from another modem.

3 CD (Carrier Detect) The CD LED lights when the modem detects a valid carrier signal from another modem. 
It is on when the modem is communicating with the other modem and off when the link is 
broken.

4 OH (Off-Hook) The OH LED lights when the modem is off-hook, which occurs when the modem is 
dialing, online, or answering a call. The LED flashes when the modem pulse-dials.

5 TR (Terminal Ready) The TR LED lights when a communication program is using the modem. It means the 
modem is ready for an outgoing or incoming call. It goes off when the communication 
program disconnects the serial port. When it goes off, a connected modem will also 
disconnect.

48A
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Uninterruptible Power Supply (UPS)

WARNING
LEAKAGE CURRENT – Electrical shock to patient could result 
from component failure and lack of power isolation.

In the event this system is used in the patient vicinity, it must be 
configured in such a way that it and all of its electrically-
connected peripheral devices are isolated from mains power to 
prevent excessive leakage current to the patient. This can be 
accomplished through the use of isolated mains power, or a 
medical grade isolation transformer (in compliance with UL 
60601, CAN/CSA C22.2 No. 601.1, IEC 60601-1) with this 
system. All nonmedical peripheral devices shall comply with IEC 
and ISO safety standards that are relevant to that equipment (i.e., 
IEC 60950, UL 60950).

Use of SEER Light Connect device in the patient vicinity requires 
that these measures are observed.

The UPS “ONEAC ONm600, Front View” on page 2-36 
meets this requirement.

Powerware 5115, Front View 
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Powerware 5115 (120 volt), Rear View 

Powerware Power Supply (Front view) 5115

Item Name Description

A Power On/Off Button Controls power to the UPS.

B Test/Alarm Reset Button Lit whenever normal utility voltages are present at the power sockets.

C Power On Indicator This indicator is green when power is on.

D On Battery Indicator This indicator is yellow when the UPS is running on battery.

E Overload Indicator This indicator is red when the UPS is overloaded.

F Service Indicator This indicator is red when the UPS requires servicing.
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Powerware 120V Power Supply 5115,
Rear view 

Item Name Description

A Network transient protector 
(OUT)

Used for network or telecommunications equipment

B Network transient protector 
(IN)

Used for network or telecommunications equipment
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Powerware 5115 (220 volt), Rear View 

C Input overcurrent protector Resettable input overcurrent protector

D 6 foot Power cord Connects to power

E DIP Switches Configures the input and output voltage

F Communication Port Allows data communication between the UPS and the computer

G Site Wiring Fault Indicator Lights up if there is no ground wire connection or if the neutral and line wires are crossed in 
the line receptacle

Powerware 120V Power Supply 5115,
Rear view (Continued)

Item Name Description
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031A

Powerware 220V Power Supply 5115 Rear view 

Item Name Description

A Network Transient Protector Used for network or telecommunications equipment

B 10 Amp Receptacles Connect equipment to the UPS

C Input Connector Connects the UPS to power

D Input Overcurrent Protector Resettable input overcurrent protector
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ONEAC ONm600, Front View 

E Dip Switch Configures the input and output voltage

F Communication Port Allows data communication between the UPS and the computer

Powerware 220V Power Supply 5115 Rear view (Continued)

Item Name Description

A

B

020A

ONEAC ONm600 Front View 

Item Name Description

A Status LEDs Three LEDs indicate the UPS status.
 Power - When the green LED is on, either solid or blinking, power is being supplied to the 

output. If blinking, it indicates the UPS is on inverter or there is an overload condition.
 Battery - When the yellow LED is on solid, the UPS is on inverter. If blinking, it indicates the 

battery is charging when on line or low battery if running on inverter.
 Fault - When the red LED is on solid, it indicates there is a problem with the battery charger 

or Operating Instructions ON Series m UPS User Instruction Manual 11 inverter. If blinking, 
it indicates no battery, overload or high line and no battery present. See the label on back of 
the UPS for LED fault status information, (or download the ONEAC service manual for LED 
fault status information. See “OEM Documentation and Support” on page 1-6.)

B Power On/Off Button Controls power to the UPS
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ONEAC ONm600, Rear View 
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ONEAC ONm600 Rear View 

Item Name Description

A Interface Serial Port Allows data communication between the UPS and the computer

B Power Input Connects to AC power. Use the AC power supply cord supplied with the UPS

C External Battery Input 
Connector

Connection for adding additional external battery for longer battery runtime. See “OEM 
Documentation and Support” on page 1-6 and download the ONEAC service manual for more 
information

D Power Outlets Connect equipment to the UPS

E LED Fault Status Chart Describes the fault reason matching the LED status
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Isolation Transformer 

WARNING
LEAKAGE CURRENT – Electrical shock to patient could result 
from component failure and lack of power isolation.

In the event this system is used in the patient vicinity, it must be 
configured in such a way that it and all of its electrically-
connected peripheral devices are isolated from mains power to 
prevent excessive leakage current to the patient. This can be 
accomplished through the use of isolated mains power, or a 
medical grade isolation transformer (in compliance with UL 
60601, CAN/CSA C22.2 No. 601.1, IEC 60601-1) with this 
system. All nonmedical peripheral devices shall comply with IEC 
and ISO safety standards that are relevant to that equipment (i.e., 
IEC 60950, UL 60950).

Use of SEER Light Connect device in the patient vicinity requires 
that these measures are observed.

The following isolation transformers meet these requirements:

 ONEAC PCm Series 500—1000 VA Power Conditioner 
See “ONEAC PCm Series 500–1000 VA Power Conditioner” 
on page 2-39 for more information.

 Powervar ABC MED Series Power Conditioner
See “Powervar ABC MED Series Power Conditioner” on 
page 2-41 for more information.
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ONEAC PCm Series 500–1000 VA Power Conditioner

The MARS system uses a variety of models in the ONEAC PCm series 500 through series 
1000 power conditioners. The features and controls are similar among the supported models.

ONEAC ONm6PCm Series 500 – 1000 VA (front view)

Item Name Description

A Output Power LED Indicates equipment is connected to the isolation
transformer and drawing power.
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ONEAC ONm6PCm Series 500 – 1000 VA (rear view)

Item Name Description

A Power On/Off Button Controls power to the UPS

B Power Input Connects to AC power. Use the AC power supply cord supplied with the UPS

C Power Outlets Connect equipment to the UPS
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Powervar ABC MED Series Power Conditioner

The MARS system uses a variety of models in the Powervar ABC MED series power 
conditioners. The features and controls are similar among the supported models.

Powervar ABC MED Series Power Conditioner (front view)

Item Name Description

A Power On/Off Button Controls power to the isolation transformer

B Power LED Indicates the isolation transformer is on and connected
to AC power.

C Safety Ground Missing
LED

Indicates that a device connected to the isolation
transformer is missing the safety ground.
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Powervar ABC MED Series Power Conditioner (rear view)

Item Name Description

A Power Outlets Connects equipment to the isolation transformer.

B Power Inlet Connects to AC power. Use the AC power supply cord
supplied with the isolation transformer.
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Monitors

Please refer to the owner’s manual that shipped with the monitor for any necessary 
information. 

Printers

Please refer to the Owner’s Manual that shipped with the printer for any necessary 
information. .

Monitors

Size Brand Model

17 inch Compaq V7550

18 inch NEC 1880SX

19 inch NEC 1990SXi

19 inch HP L1910

19 inch HP LE1911

21 inch Sony CPD-G520P

Printers

Type Brand Model

LaserJet HP 1200N

LaserJet HP P4200N

LaserJet HP P4250N

LaserJet HP P4015N

Laser Ricoh SP4100N
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Network Setup: Introduction
Introduction

Before beginning this network setup, consult with the hospital Information 
Technology (IT) department and determine if the site is planning to use 
workgroups or a domain. If using workgroups, gather the user name, 
password, and computer name. If using domain, gather the user account 
domain and computer domain information.
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Network Setup for Windows 2000/2003 Systems

MARS system’s running Windows 2000 or Windows 2003 are shipped with 
one user account. Additional user accounts may be added. 

Default Factory Setup 

At the factory and during a rebuild, all MARS Holter Analysis server, client 
and standalone systems are setup to use Windows workgroups by default. A 
new workgroup (MARSWORKGROUP) is set up automatically at the MARS 
Holter Analysis server to provide secure client access to the drive shares.

A drive share with read/write/execute permission is set up automatically for 
“<server drive letter>:\gemsit” (with a drive share name of “gemsit”) to allow 
the client to access the reports and slots directories.

The mei user account is automatically created and added to the 
MARSWORKGROUP. All new users added to the MARSWORKGROUP will 
have access to the drive shares.

IMPORTANT

To protect the MARS™ Holter Analysis System from viruses, the 
appropriate anti-virus software should be installed before connecting the 
system to the network. It is recommended that the customer turn on the 
anti-virus software auto protect option, and keep the virus definitions 
current to avoid virus infections. Please discuss virus protection with the 
hospital Information Systems (IS) department before proceeding with the 
network installation of this equipment.

In addition to installing anti-virus software, it is recommended that the 
customer limit drive share access for additional virus protection. This 
can be accomplished by changing the share permissions for the gemsit 
folder. It is recommended that permissions be set for individual users, 
rather than the entire MARSWORKGROUP or an entire domain. This 
will change the default factory setup.

Adding New Users to Workgroups

To add a new user to a workgroup you must add the user to the MARS 
Holter Analysis server and to the MARS Holter Analysis client.

NOTE
For technical support, call the Jupiter Remote On-Line Center at 1-800-
558-7044. If you need technical support and you are not in the US, see 
“How to Reach Us...” at the front of this manual to determine who to 
contact for technical support.

To verify that the MARS™ Holter Analysis System is operating correctly, 
complete the “Checkout Procedure” on page 7-3.
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Domain Network

If a customer has its own domain controller, the MARS Holter Analysis can 
be added to the domain. The advantage of using a domain controller over 
the workgroup is that is allows for centrally controlled user administration.

If you create a new user account on a domain controller, the new account is 
automatically added as a member of that domain.

Joining MARS Holter Analysis to a Domain

NOTE
This section is only needed if the customer intends to configure the 
MARS Holter Analysis to join a domain and does not want to use the 
workgroup default setup.

For technical support, call the Jupiter Remote On-Line Center at 1-800-
558-7044. If you need technical support and you are not in the US, see 
“How to Reach Us...” at the front of this manual to determine who to 
contact for technical support.

The following are the general steps necessary to add the MARS Holter 
Analysis to the domain:

1. The customer must provide the domain name to be used.

2. Add the user names to the domain.

3. Configure the MARS Holter Analysis server and the clients to join the 
domain.

NOTE
Standalone units can also be added to the domain, but there is no 
advantage to doing this.

4. Configure the gemsit drive share on the server with full control 
permissions for the domain users.

5. Continue with “Network Setup for Clients” on page 3-5.

Network Setup for Clients

Use the following window to set up the client with the server name or server 
IP address.
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1. Launch the MARS application (see “Power On Procedure” on page 4-4).

2. Select System > System Setup > Network.

3. To enter a server name or IP address, select Enter MARS server 
information manually and then type in the server name or the IP 
address. Continue with step 4.

or

Choose Select server from list of MARS systems found on the network. 

a. A progress bar displays as the system searches for all MARS 
servers on the network.

b. Select the server to which this client should connect.

4. Select Save.

5. To verify that the MARS™ Holter Analysis System is operating correctly, 
complete the “Checkout Procedure” on page 7-3.

95A
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Software Upgrade and Network Setup for Windows 
NT Systems

Standalone and Client Configurations

1. Determine if the MARS Holter Analysis system has Ethernet capabilities.

2. Add network drivers if necessary.

3. Set up the network.

4. Check out the system.

Ethernet Capabilities

If the system does not have an Ethernet card it cannot be attached to the 
network or communicate with the MUSE system. There is no network 
upgrade kit available for these units.

The systems can support the tape acquisition unit if the optional SCSI board 
is installed. See “Tape Acquisition Unit (Optional Device)” on page 5-9.

Determine if adding Network Drivers is Necessary

All MARS Holter Analysis systems that have a product code of PU have 
network capability. The PU product code units were manufactured in the 
United States, and run on a Compaq or Hewlett Packard box. You must 
confirm that units without the PU product code contain a network card. 

Looking at the serial label on the back of the unit to determine:

Adding Network Drivers

If you look at the back of the MARS Holter Analysis system (catalog number 
2006542-002) and see an Ethernet connector, the system has network 
capabilities, but the network drivers must be installed. Use the Installation 
Guide, part number 2006531-006, for instructions on adding network drivers.

Software Upgrade for Windows NT

Before beginning this setup, consult with the hospital Information 
Technology (IT) department and determine if the site is planning to use 
workgroups or a domain. If using workgroups, gather the user name, 

if the MARS Holter Analysis... then go to...

has a PU product code “Software Upgrade and Network Setup for 
Windows NT Systems” on page 3-7

has catalog number 2006542-002  “Adding Network Drivers” on page 3-7
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password, and computer name. If using domain, gather the user account 
domain and computer domain information.

NOTE
This section is for upgrading a MARS Holter Analysis standalone 
workstation to a client configuration, or to a new standalone 
configuration that has networking capabilities. The system must be 
running software revision 5.10 or higher to upgrade to version 7.

NOTE
See “Configuration Options” on page 2-6 for information about the 
standalone and client configurations. Windows NT does not support the 
MARS server software.

Enter Administrator Mode

You must be logged on as the administrator before performing software 
upgrades.

1. Determine the manufacturer name that appears on the front of the 
system box.

2. Reboot the system and log on as the administrator.

 If you have a MARS Holter Analysis running on a Compaq or 
Hewlett Packard box:

at the user name and at the password prompt, type mei. 

or

 If you DO NOT have a Compaq or Hewlett Packard box:

at the user name prompt, type MHDAdmin and at the password 
prompt, type notnagel.

Begin Upgrade

NOTE
Depending on whether this is an upgrade or a new installation, some 
screens during the installation wizard may not be required. The 
installation procedure below is for a new installation. If any step does not 
appear during the installation process, go on to the next step.

Do not run any other applications while installing MARS Holter Analysis 
software. Close all windows before inserting the application CD.

1. The PC must be in Administrator Mode to load software. See “Enter 
Administrator Mode” on page 3-8.

2. Install the MARS dongle.

3. Insert the MARS Holter Analysis application CD into the CD drive. Allow 
the MARS installation program to start automatically.

4. Choose the desired language from the Choose Setup Language window 
and click Next.

5. The Installing Dongle Drivers message displays for about 7 seconds.

6. Click Next at the Welcome to the InstallShield for MARS window.
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7. Read the License Agreement, and if you agree, click Yes.

8. The Installation Mode window is displayed.

9. Click the Verify Only icon.

10. Click the MARS System Type icon to scan the computer for minimum 
requirements needed for that system type.

11. View the System Verification Results to verify that the computer has the 
minimum requirements to install MARS v7.

001A

002A
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12. Click Back and then Back again to go back to the installation wizard.

NOTE
Click Next and then Print to capture the report in SnagIt and save 
the report as a JPEG image. Then click Finish to exit the installation 
wizard. If you choose to print the report, you must start the 
installation from the beginning.

13. Click the Install MARS PC icon.

14. At the MARS Install window, select either Typical install or Custom 
Install.

15. Select the MARS System Type.

003A

004A
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16. Click Next at the Destination Disk window.

NOTE
Click Yes if you get a popup stating The directory where MARS will 
be installed already exists.

17. Select the desired number of SEER Slots and Tape Slots for MARS and 
click Next.

18. Select the OmniDrive Driver Setup for the MARS system:

 OmniDrive USB Professional – for use with a USB port. If USB is 

009A

008A

005A
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stated on the OmniDrive device, select this option.

 OmniDrive Professional – for use with a parallel port

19. Select the desired Startup option and click Next.

a. Messages pop up indicating the installation of Flash Card Reader, 
PKZip, and pcAnywhere.

b. The MARS installation begins.

c. The installation may take from 5 to 15 minutes. Do not interrupt the 
installation.

20. At the Would you like to view the installation report? prompt, click:

 Yes – to print the installation report to SnagIt

 No – to skip the installation report

21. Select Yes, I want to restart my computer now and click Finish.

The computer restarts. MARS v7 is now installed.

22. Remove the CD from the drive and store it in a secure location.

23. Go to “Verify Software Version” on page 3-12.

Verify Software Version

24. Start the MARS Holter Analysis application.

a. Click on Help.

b. Click on About.

c. Verify that the correct revision appears.

NOTE
If any other revision appears, call GE Healthcare technical support.

25. The upgrade is complete.

Go to “Network Setup for Windows NT” on page 3-13.

007A
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Network Setup for Windows NT

1. Right-click Network Neighborhood on the desktop.

2. Select Properties.

3. Select Protocols.

4. If TCP/IP Protocol is listed, right-click on it and select Properties. 
Proceed to step 6.

5. If TCP/IP Protocol is not listed, select Add.

a. Select TCP/IP Protocol.

b. Select OK.

c. Select Yes or No to DHCP Question.

d. Click Continue at the Windows NT Setup window.

e. Click Close in the Network window.

6. If using DHCP, select Obtain an IP address from a DHCP Server and 
select OK.

Or

If not using DHCP: 

a. Enter the IP address, Subnet mask, and Default gateway 
information.

b. Select OK.

7. Select Yes at the Restart your computer? window.

8. Logon to the computer as the administrator.

9. Right-click Network Neighborhood on the desktop.

10. Select Properties.

11. Select the Identification tab.

12. Select Change.

13. Enter your unique Computer Name.

14. If you select Workgroup, enter a unique workgroup name or to add 
MARS workgroup, type MARSWORKGROUP.

Or 

If you select Domain, enter the domain name given by the hospital IT 
department.

15. Select OK.

16. Select Close.

17. At the Restart message, click Yes.

18. Go to “Network Setup for Clients” on page 3-5 to complete the network 
setup for the client.
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For your notes
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Maintenance: Introduction
Introduction

Maintenance Guides

For further information please reference the appropriate OEM manuals for 
the recommended maintenance of their product. To download OEM manuals 
please see “OEM Documentation and Support” on page 1-6.

For technical support, call the Jupiter Remote On-Line Center at 1-800-558-
7044. If you need technical support and you are not in the US, see “How to 
Reach Us...” at the front of this manual to determine who to contact for 
technical support.

Items Requiring Maintenance

 MARS Holter Analysis client

 MARS Holter Analysis server

 MARS Holter Analysis standalone

 Monitor

 DVD-RW or CD-RW Drive

 Printer

 UPS or Isolation Transformer

Recommended Maintenance

GE Healthcare recommends that you perform the tests described in this 
chapter:

 Every 6 months as part of routine maintenance

 Whenever internal assemblies are serviced

 More frequently if indicated

A regular equipment maintenance program helps prevent unnecessary 
equipment and power failures and also reduces possible health hazards. 
This chapter contains instructions for the following recommended 
maintenance:

 Inspecting and cleaning the equipment

 Domestic electrical safety tests

 Workstation power supply test

 Checkout procedure

NOTE
Unless you have an Equipment Maintenance Contract, GE Healthcare 
does not assume the responsibility for performing the recommended 
maintenance procedures. The sole responsibility rests with the individual 
or institution using the equipment. GE Healthcare service personnel 
may, at their discretion, follow the procedures provided in this manual as 
a guide during visits to the equipment site.
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Required Tools and Supplies

In addition to a standard set of hand tools, you will need the special tools and 
items listed below to maintain or check out the system. 

Power On Procedure

1. Turn on the workstation.

2. Turn on the monitor power switch. Several screens appear momentarily.

NOTE
Watch for error messages on the screen. Reference the OEM 
Troubleshooting Guide that shipped with the MARS™ Holter 
Analysis System. The Troubleshooting Guide is also available on 
the Internet. For more information, see “OEM Documentation and 
Support” on page 1-6.

3. If using a local parallel printer, turn on the local parallel printer.

4. Press Crtl + Alt + Delete to access the logon window. Use the defaults 
to logon. (The defaults can be changed. Contact the system 
administrator if these logons do not work.)

 User Name is mei

 Password is mei

5. Click OK. The MARS Holter Analysis application screen appears.

NOTE
The MARS Holter Analysis application screen appears only if this 
option was selected during the software installation.

Table 21. Required Tools and Supplies 

Item Part Number

DVOM N/A

Leakage current tester MT-1216-01 (120V), 
MT-1216-02 (240V), or equivalent

CD-ROM Cleaning Kits 416627-001

Tape Cleaning and Demagnetizer kit (Used on 
tape acquisition unit)

3613-902

Holter Installation Tape 3613-602
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Safe Shutdown Procedure

CAUTION
It is important to exit the MARS application before shutting 
down the system. Failure to do so may result in the loss of 
data and damage to the MARS workstation.

NOTE
After exiting the MARS application, the remaining shutdown steps are 
the standard Windows shutdown procedure. Follow the standard 
process for shutting down the computer.

1. If you are shutting the computer down prior to MARS logon, hold down 
the following keys simultaneously: Ctrl + Alt + Delete and skip to step 5. 
If you need to exit the MARS application, begin with step 2.

2. Click System on the menu bar.

3. Click Exit on the pulldown menu. The MARS application will close.

4. Click Start located in the lower left corner of the display.

5. Select Shut Down.

6. Select Shut down from the pull-down list.

7. Select OK.
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Inspection and Cleaning

Visual Inspection

Perform a visual inspection regularly. Turn off the unit and remove power 
before making an inspection or cleaning the unit.

 Check the case and display screen for cracks or other damage.

 Regularly inspect all cords and cables for fraying or other damage. 
Perform safety tests on any repaired line cords.

 Inspect all plugs, cables, and connectors for bent prongs or pins.

 Verify that all cords, socketed components, and connectors are securely 
seated.

 Inspect keys and controls for proper operation.

 Power switches should not stick in one position.

Check Cooling Fans

Check operation of fans in:

 client workstation

 server workstation

 standalone workstation

With the workstation operating verify that all fans contained in the unit are 
operating properly.

Cleaning Precautions

Turn off the unit and remove all power before inspecting or cleaning. 

Do not immerse any part of the equipment in water.

Do not use organic solvents, ammonia based solutions, or abrasive cleaning 
agents which may damage equipment surfaces.

Ventilation

Position the workstation to ensure adequate ventilation. Poor ventilation can 
cause overheating and damage system components.

 Do not place the workstation in a position where the ventilation holes in 
the front and rear are blocked or restricted. 

 Do not place the system near ducts, pipes or equipment that generate 
heat.
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Exterior Cleaning

Clean the exterior surfaces once per month, and more frequently if needed, 
with a clean, soft cloth and a mild dishwashing detergent diluted in water.

 Wring the excess water from the cloth. Do not drip water or any liquid on 
open vents, plugs, or connectors.

 Dry the surfaces with a clean cloth or paper towel.

Cleaning the Monitor Screen

NOTE
Never use abrasive materials to clean the screen. They can damage the 
anti-reflective coating. 

Wipe the screen with a soft, dry, clean cloth to remove dust.

To remove fingerprints and other soil:

1. Wipe the screen with a soft cloth moistened with a solution of isopropyl 
alcohol, water and mild detergent.

2. Rinse the screen immediately with a cloth dampened with clean water.

3. Dry the screen with a soft, clean cloth.

Cleaning the System Interior

WARNING
Turn off power and disconnect power cord from AC power 
source before removing the cover.

The factory seals the equipment before it leaves. There should be no dust 
buildup on the surfaces of the interior PCB assemblies and components 
when you receive it.

Follow these steps to clean the system interior.

1. Power off the workstation by following the “Safe Shutdown Procedure” 
on page 4-5.

2. Unplug the AC power cord.

3. Remove the system cover to clean the interior. See the OEM’s Service 
Manual for detailed information.

4. Replace the cover.
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Cleaning the CD-RW Drive or DVD-RW Drive

Follow these steps to clean the CD-RW or DVD-RW drive.

1. Open the CD-RW or DVD-RW drive.

2. Insert the cleaning disk, brushes down, into the drive.

3. Close the CD-RW or DVD-RW drive. The activity led blinks for about 10 
seconds.

4. Remove the cleaning disk from the drive.

5. Close the CD-RW or DVD-RW drive

Cleaning the Printer

For maintenance please see the OEM User’s manual that shipped with the 
printer. The manual can also be located on the OEM website. For further 
information please see “OEM Documentation and Support” on page 1-6.

Cleaning the Tape Acquisition Unit

Cleaning and inspecting the tape acquisition unit involves several steps, 
including:

 Demagnetizing and cleaning the tape acquisition unit

 Cleaning the tape acquisition unit interior

NOTE
Demagnetize the tape acquisition unit, clean the tape drive, and 
check out the tape acquisition unit on a weekly basis.

Cleaning and Demagnetizing the Tape Drive
The cleaning and demagnetizing kit (PN 3613-902) performs cleaning of the 
audio head and demagnetization simultaneously, removing contaminants 
and magnetism build up.

NOTE
While running, the cleaning cassette will emit a buzzing sound much 
louder than a normal tape. This is normal and does not indicate a 
problem with the unit.

1. Insert the cleaning cassette into the tape acquisition unit. Gently push 
the cleaning cassette into the drive opening until the cleaning cassette 
clicks into place.

2. Turn release lever to its up position.

3. The Tape Download/Analysis Options window appears and the cleaning 
tape runs briefly (less than a second) and stops.

NOTE
An error message may appear, if the correct slot type is not available 
or all slots are full. Click Cancel in the error message box. The 
message box will disappear and the cleaning cassette will run 
normally.
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If the cleaning cassette continues to run for more than a few seconds, 
click Cancel in the Tape Download/Analysis Options window. This will 
stop the cleaning process. Contact MARS Holter Analysis technical 
support.

4. Click Cancel in the Tape Download/Analysis Options window. The Tape 
Download/Analysis Options window closes.

5. Push tape lever down to eject tape.

Interior Cleaning
The factory seals the equipment before it leaves. There should be no dust 
buildup on the surfaces of the interior PCB assemblies and components 
when you receive it. 

However, if dust is an environmental problem, use a commercially available 
dust remover (compressed air). Follow the manufacturer’s directions for its 
use.

WARNING
Only qualified personnel should dissemble this unit.

Turn off the power and disconnect power cord from the AC 
power source before removing the cover.

Opening the Unit

1. Power off the workstation.

2. Turn off the tape acquisition unit power switch.

3. Disconnect the tape acquisition unit power cord from the back of the 
UPS.

4. Remove the fifteen retaining screws from the tape acquisition unit.

NOTE
The tape acquisition unit uses fifteen screws to secure the cover in 
place. To reduce EMI emissions, replace all fifteen screws securely 
when reassembling the unit.
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5. Remove the tape acquisition unit cover. Slide the tape acquisition unit 
cover forward. 

Reassembling the Unit

1. Slide the tape acquisition unit cover over the front of the tape acquisition 
unit.

2. Install the fifteen retaining screws to secure the cover to the unit. Hand 
tighten all screws.

NOTE
The tape acquisition unit uses fifteen screws to secure the cover in 
place. To reduce EMI emissions, replace all fifteen screws securely 
when reassembling the unit.

3. Turn on the tape acquisition unit.

4. Power on the workstation. See “Power On Procedure” on page 4-4.

UPS

Battery replacement is recommended every 3-6 years. Please see the OEM 
User’s Guide for the battery replacement procedure.

Checkout Procedure

Follow the “Checkout Procedure” on page 7-3.

MD1144-334A
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Theory of Operation

The theory of operation provides a very broad overview of the system 
hardware and the various MARS Holter Analysis configurations. 

Configurations 

There are three different MARS Holter Analysis network configurations 
available using a standard Ethernet TCP/IP network. The MARS Holter 
Analysis can be configured as a client, a server, or a standalone unit.

Standalone

The MARS Holter Analysis standalone stores patient data locally, and the 
saved patient reports can be sent to a MUSE server across the network. The 
MARS Holter Analysis standalone cannot receive patient data from other 
MARS systems.

Client

The MARS Holter Analysis client allows reports to be edited and printed. The 
MARS Holter Analysis client-server configuration allows the MARS Holter 
Analysis clients to access and automatically send patient data to the MARS 
Holter Analysis server via the network. Patient reports can be sent to a 
MUSE server.

Server

MARS Holter Analysis servers store the patient data, and “serve” file 
requests from other MARS Holter Analysis clients on the network. All patient 
data will be stored on the MARS Holter Analysis server and can be accessed 
by MARS Holter Analysis clients. The server can support a maximum of 25 
MARS Holter Analysis clients. The patient reports can also be sent to a 
MUSE server.

System Hardware

The system hardware components include a motherboard, CPU 
processor(s), hard drive or drives, physical RAM, an internal CD-RW or 
DVD-RW drive, floppy diskette drive, two separate Ethernet network 
adapters, and a power supply.

It also contains audio ports, an internal speaker, parallel ports, serial ports, 
and USB ports. PCI expansion slots connect directly to the system BUS and 
allow for additional network interface cards and other devices.

The motherboard contains the main ethernet interface for connecting to the 
network. MARS non-realtime devices, such as printers or RSS access units, 
have independent ports.
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General Fault Isolation

Assistance

For technical support, call the Jupiter Remote On-Line Center at 1-800-558-
7044. If you need technical support and you are not in the US, see “How to 
Reach Us...” at the front of this manual to determine who to contact for 
technical support.

First Things to Ask

If the unit is not working properly, start by asking yourself these basic 
questions.

1. Are the unit and all peripherals turned on?

2. Have there been any changes in the use, location, or environment of the 
equipment that could cause the failure?

3. Has the unit been modified in any way, either in software or hardware?

4. Is operator error the cause of the problem? Try to repeat the user’s 
scenario exactly and compare that to the proper operation of the 
equipment. Check the operator’s manual as necessary.

Visual Inspection

A thorough visual inspection of the equipment can save time. Small things — 
disconnected cables, foreign debris on circuit boards, missing hardware, 
loose components — can frequently cause symptoms and equipment 
failures that may appear to be unrelated and difficult to track.

Read the disassembly guidelines in the product’s OEM manual before you 
perform an internal visual inspection of the components.

Take the time to make all the recommended visual checks (refer to the 
following visual inspection chart) before starting any detailed troubleshooting 
procedures.

Table 22. Visual Inspection List 

Area Look for the following problems

I/O Connectors 
and Cables

 Fraying or other damage
 Bent prongs or pins
 Cracked housing
 Loose screws in plugs

Interface Cables  Excessive tension or wear
 Loose connection
 Strain reliefs out of place
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Platform-specific Guidelines

For platform-specific guidelines, refer to the OEM service manuals and 
troubleshooting guides for troubleshooting the MARS™ Holter Analysis 
System. The OEM troubleshooting guide is shipped with the unit and is also 
available on the OEM website. For further information see “OEM 
Documentation and Support” on page 1-6.

For technical support, call the Jupiter Remote On-Line Center at 1-800-558-
7044. If you need technical support and you are not in the US, contact your 
GE Healthcare representative.

Platform-specific Error Codes

For a list of Power-On-Self-Test (POST) messages please reference the 
OEM troubleshooting guide that shipped with the MARS™ Holter Analysis 
System. The troubleshooting guide is also available on the OEM website. 
For further information please see “OEM Documentation and Support” on 
page 1-6.

Replacing Workstation Hardware and Peripherals

Use the troubleshooting process located in the OEM service manual for the 
additional SCSI, serial, and parallel boards. See “Replacing SCSI, Serial or 
Parallel (LPT) Boards” on page 5-6 for additional board locations. 

See the OEM service manual for additional detailed instructions. If you have 
a question that is not answered in the OEM service manual or if you would 
like further assistance, call the Jupiter Remote On-Line Center at 1-800-558-
7044. If you need technical support and you are not in the US, see “How to 

Circuit Boards  Moisture, dust, or debris (top and bottom)
 Loose or missing components
 Burn damage or smell of over-heated components
 Socketed components not firmly seated
 PCB not seated properly in edge connectors
 Solder problems: cracks, splashes on board, incomplete 

feedthrough, prior modifications or repairs

Ground Wires/
Wiring

 Loose wires or ground strap connections
 Faulty wiring
 Wires pinched or in vulnerable position

Mounting 
Hardware

 Loose or missing screws or other hardware, especially fasteners 
used as connections to ground panes on PCBs

Power Source  Faulty wiring, especially AC outlet
 Circuit not dedicated to system
 (Power source problems can cause static discharge, resetting 

problems, and noise.)

Table 22. Visual Inspection List (Continued)

Area Look for the following problems
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Reach Us...” at the front of this manual to determine who to contact for 
technical support.

Replacing SCSI, Serial or Parallel (LPT) Boards 

The information provided for replacing SCSI, serial or parallel (LPT) boards 
applies to Compaq Evo D510, Hewlett Packard (HP) D530 CMT, and HP 
dc7100 CMT platforms only. They do not apply to the HP dc7600 CMT, the 
HP dc5750, or the HP rp5700 systems. 

Confirm you have the correct location before removing and replacing any 
circuit boards.

NOTE
The image will not work if the mother board configuration below is not 
followed. 

The parallel (LPT) board has an additional connector (referred to as LPT 
3) on it, which the card reader plugs into. The parallel (LPT) board plugs 
into the PCI 2 mother board slot. See the Mother Board Slots table 
below for more information.
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Table 23. Mother Board Slots 

# D510 D530 dc7100

1

Serial Port. 
Connects to UPS / 

Isolation Transformer

Serial Port. 
Connects to modem.

Serial Port. 
Connects to UPS / 

Isolation Transformer

2

PCI Slot: 
Contains SCSI board. 
Connects to optional 

tape acquisition device

Serial Port. 
Connects to UPS / 

Isolation Transformer

Parallel Port.
Connects to printer.

3

PCI Slot. 
Contains parallel port; 

connects to printer.

PCI Slot: 
Contains SCSI board. 
Connects to optional 

tape acquisition device

PCI Slot:
Contains Serial Port. 
Connects to modem.

4

PCI Slot.
Empty

PCI Slot. 
Contains parallel port; 

connects to printer.

PCI Slot.
Empty

5

PCI Slot:
Contains Serial Port. 
Connects to modem. 

PCI Slot.
Empty

PCI Slot: 
Contains SCSI board. 
Connects to optional 

tape acquisition device

6

PCI Slot
Contains spare 

Serial Ports. 

PCI Slot.
Empty

PCI Slot
Contains spare 

Serial Ports

7

PCI Slot
Contains spare 

Serial Ports

PCI Slot.
Empty

8

PCI Slot.
Empty

9

PCI Slot.
Empty
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Monitor

The monitor is a field replaceable unit.

Fault Detection

If the monitor is not working correctly, try the following:

 Verify the power and video connections.

 Follow the shutdown procedure in “Safe Shutdown Procedure” on 
page 4-5, to shutdown the system; then power the system on again.

 Reference the manual that came with the monitor.

 Contact tech support for further assistance.

Keyboard

The keyboard is a field replaceable unit.

Mouse

The mouse is a field replaceable unit.

Printer

The printer is a field replaceable unit.

For troubleshooting please see the OEM User’s manual that shipped with 
the printer. The manual can also be located on the Hewlett Packard website. 
For further information please see “OEM Documentation and Support” on 
page 1-6.

Isolation Transformer

The isolation transformer is a field replaceable unit.

For troubleshooting please see the OEM manual that shipped with the UPS. 
The manual can also be located on the manufacturer’s website. For further 
information please see “OEM Documentation and Support” on page 1-6.

If the isolation transformer is not working correctly, do the following:

1. Verify the connections.

2. Verify the wall outlet is not faulty by plugging the unit into a different 
outlet. Have a qualified electrician repair any faulty outlets. 

3. If necessary, contact technical support for further assistance.

Uninterruptible Power Supply

The UPS is a field replaceable unit.
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For troubleshooting please see the OEM manual that shipped with the UPS. 
The manual can also be located on the manufacturer’s website. For further 
information please see “OEM Documentation and Support” on page 1-6.

NOTE
Only use the serial cable which was shipped with the UPS. 

If the UPS is not working correctly, do the following:

1. Verify the connections.

2. Verify the wall outlet is not faulty by plugging the unit into a different 
outlet. Have a qualified electrician repair any faulty outlets. 

3. Press and hold the test button for three seconds. If the test LED 
illuminates see the “Troubleshooting” section of the OEM manual for 
further information.

4. If necessary, contact technical support for further assistance.

RSS Analog Modem

The RSS modem is a field replaceable unit.

The MARS™ Holter Analysis System uses a non-networked analog modem 
for Remote System Support (RSS). The RSS access unit allows GE 
Healthcare to maintain, and if necessary, to diagnose and to repair the 
workstation software in a timely manner.

Fault Detection

If the modem is not working correctly, do the following:

1. Verify the connections.

2. Verify the power supply plugged into the modem is working.

3. Verify the software is running by:

a. Select Control panel.

b. Select Services.

c. Verify pcAnywhere Host Service has a status of Started.

If necessary start the Host service and configure it to start 
automatically.

4. Contact technical support to verify that they can remotely access the 
system.

Tape Acquisition Unit (Optional Device)

The tape acquisition unit is a field replaceable unit.

The tape acquisition is an optional device. The acquisition unit reads and 
downloads 8500 tapes to the MARS™ Holter Analysis System.
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The HP dc7600 CMT, HP dc5750, and HP rp5700 do not support the tape 
acquisition unit.

Fault Detection

If the tape acquisition unit is not working correctly, do the following:

1. Verify the connections.

2. If necessary, follow the shutdown procedure in “Safe Shutdown 
Procedure” on page 4-5, to shutdown the system; then power the 
system on again.

Refer to the operator’s manual for the correct shut down procedures.

3. Verify data from a tape can be acquired.

NOTE
Refer to the MARS Holter Analysis operator’s manual for further 
assistance on acquiring data from the tape acquisition unit.

Replace / Install the SCSI Board for the Tape Acquisition Unit

The SCSI board/tape acquisition unit is available in two separate kits:

 Domestic Kit – See Table 15, “SCSI Board for Tape Acquisition 
(Domestic) Kit PN 2026559-001 (not compatible with HP dc7600 CMT 
systems),” on page 8-11 for ordering SCSI boards and Tape Acquisition 
units with a 110v internal power supply.

 International Kit – See Table 16, “SCSI Board for Tape Acquisition 
(International) Kit PN 2026559-002 (not compatible with HP dc7600 CMT 
systems),” on page 8-11 for ordering SCSI boards and Tape Acquisition units 
with a 220v internal power supply.

CAUTION
Electrostatic discharge (ESD) can harm the SCSI board. 
The following guidelines help protect the board.

 Discharge any static charge you may have built up 
before handling the SCSI board. (Touch a metal surface 
to discharge a spark.)

 Handle the SCSI board by its edges. Do not touch the 
semi-conductor components on the board.

The SCSI board installation applies to all three hardware systems with one 
difference. For:

 HP dc7100 – install the SCSI board into slot 1 (as shown in the picture 
below).
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 Compaq D510 and HP D530 – install the SCSI board into slot 1 (if not already 
being used). If slot 1 is already used, install in any available slot with an 
interface plug.

1. Shutdown the MARS™ Holter Analysis System, turn off the power, and 
remove the power cord.

2. Remove the side cover.

3. Remove the cover from slot 1. (Or an available slot if D510 and D530.)

NOTE
The picture below shows an HP dc7100 system with a hinged 
locking device for the slot covers. Other systems may have a screw 
fastener for the slot covers.

4. Align the plug of the SCSI board with the interface plug and, using an 
even pressure along the edge of the SCSI board, gently press the SCSI 
board into place.

5. Fasten the SCSI board into the slot using the slot fasteners.

6. Plug in the power cord.

BIOS Setup

The BIOS setup applies to all three hardware systems, with one difference 
during the first step.

1. Boot up the system and during system boot perform one of the following 
for the appropriate hardware:

 For dc7100 – press Esc key when the HP Invent blue screen is 
displayed.

 For D510 and D530 – Press Ctrl + A to enter the Adaptec 
SCSISelect utility, when Adaptec SCSI messages are displayed.

2. Using the arrow keys highlight 29320 A device and press Enter to 
configure.

Slot One

Slot One 
Interface Plug
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3. If Disable HostRAID Support option is not displayed, using arrow keys 
highlight Configure/View SCSI Controller Settings and press Enter.

4. Using arrow keys highlight Disable HostRAID Support option if it is 
displayed and press Enter.

5. Press Esc (twice, if you were in Controller Settings screen) to return to 
the SCSI device selection screen.

6. Using the arrow keys highlight 29320 B device and press Enter to 
configure.

7. If Disable HostRAID Support option is not displayed, using arrow keys 
highlight Configure/View SCSI Controller Settings and press Enter.

8. Using arrow keys highlight Disable HostRAID Support option if it is 
displayed and press Enter.

9. Press Esc (twice, if you were in Controller Settings screen) to return to 
the SCSI device selection screen.

10. Press Esc to exit the Adaptec SCSISelect utility.

11. Select Yes and press Enter to exit the utility and reboot the system.

The Tape Acquisition unit can now be connected to the MARS Workstation.

Card Reader – Omni Drive (Optional Device)

The card reader is a field replaceable device.

Some MARS™ Holter Analysis Systems are shipped from the factory with 
an internal card reader device. Other MARS™ Holter Analysis Systems are 
shipped from the factory with an external card reader device. The card 
reader reads and downloads SEER MC and SEER Light data cards to the 
MARS™ Holter Analysis System.

Fault Detection

If the card reader device is not working correctly, do the following:

1. Verify the connections.

2. If necessary, follow the shutdown procedure in “Safe Shutdown 
Procedure” on page 4-5, to shutdown the system; then power the 
system on again.

3. Verify the SEER Light data can be acquired.

NOTE
Refer to the MARS Holter Analysis operators manual for further 
assistance on acquiring data from a SEER device.

Replacing the Internal Omni Drive Card Reader

When replacing the internal card reader:

1. Connect the ribbon cable to the LPT-3 connector. The LPT-3 connector 
is on the parallel port extension card, which is located inside the EVO 
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D510 and EVO D530 system. See “Replacing SCSI, Serial or Parallel 
(LPT) Boards” on page 5-6 for additional information.

2. Connect the power connector on the card reader to the power supply. 

Installing / Replacing the External Omni Drive Card Reader

There is no power connection for the external Omni Drive card reader; it 
receives power via the USB port.

NOTE
The USB card reader cannot be used with Windows NT systems.

1. If installing the card reader for the first time:

a. Connect the USB cable to any USB port.

2. If replacing the card reader:

a. Remove the old USB OmniDrive unit, noting the port to which it was 
connected.

b. Connect the USB cable from the new USB OmniDrive to the same 
USB port where the old one was connected.

3. If necessary, logon to the system.

4. The Found New Hardware window will appear. If the Hardware Wizard 
asks for OmniDrive software, insert the MARS Holter Analysis Support 
CD. Browse to the location of the OmniDrive software.

NOTE
If the card reader (Omni Drive) drive letter assigned is other than O: 
it will have to be changed:

a. Right-click on the My Computer icon on the desktop. Select 
Manage.

b. Click on Disk Management.

c. Right-click on Disk 1 Removable and select Change Drive Letter.

d. Select Edit.

e. Select O:.

f. Click OK.

g. Click Yes.

h. Close the Computer Management window. 

DVD-RW, CD-RW, or Floppy Drive

The DVD-RW, CD-RW and floppy drives are field replaceable units.

For troubleshooting please see the OEM User’s manual. The manual is 
available on the website. For further information please see “OEM 
Documentation and Support” on page 1-6.

If the device is not working properly, do the following:
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1. Verify that the device can archive data to the correct media. Reference 
the MARS Holter Analysis operators manual for further assistance on 
archiving data.

2. Verify the connections.

3. If necessary, follow the shutdown procedure in “Safe Shutdown 
Procedure” on page 4-5, to shutdown the system; then power the 
system on again.

4. If still not working, replace the unit.

SEER Light Connect Device

WARNING

LEAKAGE CURRENT—Electrical shock to patient could 
result from component failure and lack of power isolation. 

In the event this system is used in the patient vicinity, it must 
be configured in such a way that it and all of its electrically-
connected peripheral devices are isolated from mains 
power to prevent excessive leakage current to the patient. 
This can be accomplished through the use of isolated mains 
power, or a medical grade isolation transformer (in 
compliance with UL 60601, CAN/CSA C22.2 No. 601.1, IEC 
60601-1) with this system. All non-medical peripheral 
devices shall comply with IEC and ISO safety standards that 
are relevant to that equipment (i.e., IEC 60950, UL 60950).

Use of the SEER Light Connect device in the patient vicinity 
requires that these measures are observed.

Software Version 

To view the software version of the SEER Light Connect device, click About 
in the SEER Light Hookup window. 
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ECG Cannot Be Previewed with SEER Light Connect Device
ECG cannot be previewed 

with the SEER Light 
Connect Device.

Is the distance from 
the controller within 

4.9 ft. (1.5 m)?

Position the controller 
within 4.9 ft (1.5 m).

Is the I.R.
window facing the 

controller properly?

Reposition the I.R. window 
properly, or remove any 
obstacle between the 

recorder and the controller.

Were the batteries 
installed within one 

hour?

Reinstall the batteries.

Has recording 
already started?

Call GE service.

Cannot preview ECG by I.R. 
operation if more than 3 

minutes has elapsed since 
recording started.

Yes

No

Yes

Yes

No

No

No

Yes

Is the USB cable 
from the Connect 

plugged in?

Plug it in.Yes

No

Is the orange LED 
on the Connect on?

Call GE Service.
Yes

No
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Recording Cannot Start with the SEER Light Connect Device

Recording cannot start 
with the Connect.

Does the controller 
display “untransmitted 

data?”
Transfer previous data or 
press the START button.

Does
the controller display 

“Already started?”

Reinstall the batteries over 30 
seconds after removing them.

Is the distance 
from the Connect 

within 4.9 ft 
(1.5 m?)

Adjust the position 
within 4.9 ft. (1.5 m) 
from the Connect.

Does the I.R. window 
face the Connect 

properly?
Reposition the I.R. windows 
to face each other properly. 

Remove any obstacles 
between the recorder and 

the Connect.Call GE Service.

Yes

Yes

No

No

Yes

Yes

No

No

Is the USB cable 
from the Connect 

plugged in?

Plug it in.Yes

No

Is the orange LED 
on the Connect on?

Call GE Service.

No

Yes
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Cannot Transfer Data from the Recorder to the SEER Light Connect Device

Cannot transfer data to 
the Connect.

Is the transfer
cable properly
connected?

Connect the 
cable properly.

Does the
controller display “No data 

in the recorder?”

No data in the recorder. 
Record ECG again.

Is the data output 
connector clean?

Clean the data output 
connector.

Call GE Service.

No

Yes

Yes

No

Yes

No

Is the transfer 
cable damaged?

Call GE Service.
No

Yes

Is the USB cable 
from the Connect 

plugged in?

Plug it in.

  Yes

No

Is the orange LED 
on the Connect on?

Attach the Connect to the 
recorder.

No

Yes Is the green LED on 
the Connect on?

Call GE Service.

No

Yes
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Recording Start Date/Time is Not Correct
Recording start date/time 

is not correct.

Is date correct on 
the PC?

Adjust date/time on the PC.

Call GE Service.

Yes

No
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System Rebuild: Introduction
Introduction

If a MARS system becomes corrupt, it may be necessary to rebuild it. This chapter describes 
that process. 

Process Overview

The general rebuild process remains the same regardless of what platform the system runs 
on or whether it is a standalone system, a client, or a server. It consists of the following tasks:

1. Backing up configuration and activator codes.

2. Re-imaging the platform.

3. Install MultiTech MT9234ZBA Modem driver, if applicable.

4. Re-installing the MARS application.

5. Installing an external card reader.

Applies only for the dc7100, dc7600, dc5750, and rp5700 platforms.

6. Increasing the number of installed licenses.

Applies only to servers running 25 clients. 

7. Restoring the configuration and activator codes.

8. Setting the operating system language.

Applies only to systems running Windows 2000.

9. Installing the SEER Light Hookup.

Although the general process is the same for all platforms and system roles, specific steps 
within each task may differ. Platform– or system–dependent differences are noted where 
applicable. 

Requirements

To rebuild a MARS system, you need the following equipment:

Item Description

MARS Image CD The Image CD you need depends on both the hardware 
platform you are imaging and whether the system will be used 
as a standalone system, a client system, or a server. 

MARS Application CD The Application CD you need depends on which version of the 
MARS application you will be re-installing. 

MARS Support CD The Support CD you need depends on which version of the 
MARS application you will be re-installing 

USB Storage Device This can be either an external USB floppy drive or a USB flash 
drive. 

USB Dongle This is required to install and run the MARS application. 
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Backing Up Configuration and Activator Codes

System configuration and activator codes must be saved to an external backup device before 
the rebuild begins. The device may be a floppy disk drive, CD-ROM drive, or USB flash drive, 
depending on the platform to be rebuilt. The backup will be restored after the rebuild is 
complete. 

Refer to the following instructions to create the backup.

1. Launch the MARS application.

2. Insert the storage media in the appropriate drive.

3. Select System > System Setup > Backup and Restore.

4. Set the Backup Systems Setup check box.

5. Complete the Enter a name for the backup field. 

A name is required and can be up to 70 characters long.

NOTE
The name entered here is used to identify the backup file, xxx.mars, where xxx 
equals the name entered in this field.

6. Complete the Enter comments for the backup field.

Comments are optional and can be up to 70 characters long. 

7. Click Apply.

8. Select the appropriate drive from the Browse for Folder dialog box and click OK.

The backup begins. When it is complete, the Backup operation completed successfully 
message opens.

9. Click OK.

The Backup operation completed successfully message closes. 

10. Remove the backup disk.
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Re-imaging the MARS Platform

To restore the MARS Holter Analysis Workstation to its original factory state, a disk image is 
used. This is a destructive process: the hard drive is formatted and all existing data is 
overwritten. Therefore, disk imaging is suggested only when all other system recovery 
attempts have failed. This process can take between one to two hours to complete.

Do not proceed with this step if there is any confusion about disk imaging and its impact on 
the MARS™ Holter Analysis System. For further assistance, call technical support.

Identifying Your Platform

The re-imaging process differs slightly depending on the platform to be re-imaged. Before 
proceeding with the re-imaging, refer to the following table to determine which set of 
instructions to use. 

If your platform is not listed, refer the system rebuild instructions located in the Service 
Manual that shipped with the system.

After you complete the system rebuild, you must install the MARS application software. 

Re-imaging the HP rp5700 or dc5750 Platform

The re-imaging process is nearly identical for standalone, client, and server systems. The 
only difference is the image CD used during the process. The general process consists of the 
following tasks:

1. Setting the boot order.

2. Loading the image.

3. Activating the operating system.

4. Changing the AW_Host service. 

5. Setting the BIOS version.

6. Configuring the BIOS.

If your platform is the… as seen on… refer to…

“Compaq EVO D510, Front View” page  2-13 “Re-imaging the HP rp5800 
Platform” on page 6-11

“HP EVO D530, Front View” page  2-16

“HP dc7100, Front View” page  2-19

“HP dc7600, Front View” page  2-21

“HP dc5750, Front View” page  2-23 “Re-imaging the HP rp5700 or 
dc5750 Platform” on page 6-5

“HP rp5700, Front View” page  2-25

“HP rp5800, Front View” page  2-27 “Re-imaging the HP rp5800 
Platform” on page 11
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Setting the Boot Order

Use the following procedure to set the MARS platform’s boot order. This ensures the platform 
will boot from the image CD in the next procedure.

1. Boot or reboot the MARS platform.

2. Press and hold the F10 key during reboot until a list of languages opens. 

3. Select English and press Enter.

The Hewlett-Packard Setup Utility opens. 

4. Select Storage > Boot Order. 

The Boot Order window opens. 

5. Verify the boot order is as follows:

ATAPI CD-ROM
Hard Drive

If any other device is included, or if the order is different, change the order to match 
accordingly.

6. Press F10 to accept the changes. 

7. Select File > Save Changes and Exit. 

The system reboots. Proceed to “Loading the Image”. 

Loading the Image

Use the following procedure to load the factory image onto the HP dc5750 or HP rp5700 
platform. 

1. Insert the image media into the MARS platform’s optical drive.

Refer to the following table to identify which media to use. 

2. Boot or reboot the computer. 

The system boots to a command prompt asking if you want to image the computer.

3. Press Y. 

A command prompt appears asking you to confirm your selection.

4. Press Y. 

The image begins to load onto the computer. When it is done, it will verify the image was 
applied successfully and display a status message. 

Standalone/Client Server

HP 
dc5750

MARS DC5750 XP CD 
PN 2037289-001

MARS DC5750 Server 2003 CD
PN 2037288-001

HP 
rp5700

MARS RP5700 XP DVD
PN 2044120-001

MARS RP5700 Server DVD
PN 2044119-001
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NOTE
Both prompts are timed for 15 seconds. If you do not press a key within that time, 
the prompt will time out and you will return to root prompt. If this occurs, type clone 
and press Enter to run the re-imaging process. 

5. Remove the image CD and reboot the computer. 

One of two things happens, depending on which platform is being rebuilt. 

 On the HP dc5750, the system runs through a series of screens while it sets up the 
operating system. When it is done, it will display the logon window. Skip to step 8.

 On the HP rp5700, the Your Product Key window opens. Proceed to step 6. 

6. On the Your Product Key window, click Next.

The Do you want to enter your product key now? window opens. 

7. On the Do you want to enter your product key now? window, click No. 

The system runs through a series of screens while it sets up the operating system. 
When it is done, it will display the logon window. Proceed to step 8.

8. Enter the Username and Password and press Enter. 

If you do not know the Username or Password to use, contact technical support. In the 
United States, this would be the Jupiter Remote On-Line Center at 1-800-558-7044. 
Outside of the United States, refer to “How to Reach Us…” at the beginning of the 
manual. 

9. Proceed to “Activating the Operating System”. 

Activating the Operating System

MARS v7.2 standalone and client systems run on Microsoft Windows XP. MARS v7.2 server 
systems run on Microsoft Windows Server 2003. In both cases, the OS must be activated 
within 14 days of installation. 

1. From the Windows desktop, select Start > Activate Windows. 

2. Follow the on-screen prompts to activate Windows. 

3. When prompted for the Product Key, enter the Product Key on the Windows label 
attached to the MARS computer. 

4. After the system has been activated, proceed to “Adjusting System Date and Time”.

Adjusting System Date and Time

After activating the operating system, verify that the system’s date and time settings are 
correct. If not, adjust them accordingly. 

Changing the AW_Host Service

By default, a Windows Explorer window opens each time you insert a SEER memory card. To 
change this behavior, use the following procedure to modify the AW_Host service.

1. From the MARS desktop, select Start > Run. 

The Run dialog box opens. 
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2. Type regedit and click OK. 

The Registry Editor opens. 

3. In the left hand pane, select HKEY_LOCAL_MACHINE > System > 
CurrentControlSet > Services > AW_HOST.

4. In the right-hand pane, right-click on Start and select Modify. 

The Edit DWORD Value dialog box opens. 

5. Change the Value Data to 1 and click OK. 

The Edit DWORD Value dialog box closes. 

6. Close the Registry Editor. 

Installing MultiTech MT9234ZA Modem Driver

Refer to the MultiTech Modem MT9234ZBA Driver Installation Instructions (PN 2046472-001) 
to install the MultiTech MT9234ZBA Modem Driver, if applicable. This step is not needed if 
you have a MT5634ZBA modem.

Setting the BIOS Version

For MARS v7.2 systems to operate correctly, they must be updated with the appropriate 
BIOS, as indicated in the following table: 

Use the utility found on the MARS Support CD to update to the correct version of the BIOS. 

1. From the Windows desktop, insert the appropriate MARS Support CD into the optical 
drive. 

2. From within Windows Explorer, run the appropriate file. 

Replace D:\ with the letter of the optical drive. 

BIOS Version

HP dc5750 2.10

HP rp5700 1.06

Support CD Part Number

HP dc5750 MARS V7 DC5750 SUPPORT CD 2025437-004

HP rp5700 MARS V7 RP5700 SUPPORT CD 2025437-005

For Run this file

HP dc5750 D:\DC5750_HPQFLASH\HPQFLASH.EXE

HP rp5700 D:\RP5700_HPQFLASH\HPQFLASH.EXE
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A window opens to guide you through the process of flashing the BIOS with the correct 
version 

3. Follow the prompts, clicking Next when appropriate. 

When the flash is complete, a window opens to let you know the BIOS was updated and 
informing you the system will be rebooted for the change to take effect. 

4. Click Restart to reboot the system. 

If you do not, the system will reboot automatically after one minute. 

5. Log on to the MARS platform and proceed to “Configuring the BIOS”. 

Configuring the BIOS

To ensure that all MARS systems operate consistently, the BIOS settings must be configured 
consistently across all systems. To do this, you can load the CPQSETUP.TXT file from the 
MARS Support CD within the BIOS. This requires that the file be copied from the support CD 
to the root directory of a USB device, either a USB floppy drive or a USB flash drive. 

1. From the Windows desktop, insert the appropriate MARS Support CD into the optical 
drive. 

2. Insert your USB device into any available USB port. 

3. Copy the appropriate file from the support CD to the root directory of the USB device. 

Replace D:\ with the letter of the optical drive. 

4. Remove the MARS Support CD, but leave the USB device in place.

The BIOS Utility will not be able to detect the USB device if the device is not attached 
while the system reboots. 

5. Reboot the system. 

6. When the HP Invent splash screen appears, press F10 to load the Hewlett-Packard 
BIOS Utility. 

7. Select English and press Enter.

The Hewlett-Packard Setup Utility opens. 

8. Select File > Replicated Setup.

The Replicated Setup options open. 

Support CD Part Number

HP dc5750 MARS V7 DC5750 SUPPORT CD 2025437-004

HP rp5700 MARS V7 RP5700 SUPPORT CD 2025437-005

For Copy this file

HP dc5750 D:\DC5750 BIOS Settings\CPQSETUP.TXT

HP rp5700 D:\RP5700 BIOS Settings\CPQSETUP.TXT
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9. Select the Restore From Removable Media option and press F10 to accept the 
selection. 

You are prompted to select the device from which to restore the configuration. 

10. Select USB and press F10.

When the configuration has been restored, a success message appears.

NOTE
If the BIOS Utility cannot detect the USB device, an error message opens. Verify 
the USB device is seated firmly in the port and repeat from step 5.

11. Press any key to close the success message. 

12. Select File > Save Changes and Exit.

The BIOS configuration is saved and the system reboots. You are now ready to reinstall 
the MARS application. Proceed to “Re-installing the MARS Application” on page 6-21.
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Re-imaging the HP rp5800 Platform

The HP rp5800 platform is used as a Client System with the Windows XP operating system.

The re-imaging process varies slightly depending on the platform’s operating system. You 
may only re-image a system with the same operating system with which it was shipped. To 
identify the operating system, refer to the Windows tag located on the side or top of the 
device.

The rebuild process consists of the following tasks:

1. Setting SATA emulation and boot order.

2. Loading the image.

3. Configuring the operating system.

4. Activating the operating system.

5. Installing the modem driver.

6. Installing required service packs.

7. Applying computer names.

8. Reinstalling the MARS application.

Each task is described in the detail in the following sections.

Setting SATA Emulation and Boot Order (All Configurations)

Use the following procedure to verify and, if necessary, set the MARS platform’s SATA 
emulation mode and boot order to ensure the platform boots from the image CD in the next 
procedure. This procedure is identical regardless of the platform’s operating system.

1. Boot the computer.

2. While the computer boots, press and hold F10 until the Hewlett-Packard Computer 
Setup utility opens.

3. Select Storage > Storage Options and press Enter.

The Storage Options window opens.

4. Verify the SATA Emulation field is set to IDE Mode.

5. Do one of the following:

 If the SATA Emulation field is set to IDE Mode, press Esc to close the Storage 
Options window without making any changes.

 If SATA Emulation is not set to IDE Mode, do the following:

a. Press the down arrow key to move the cursor to the SATA Emulation field.

b. Press the right arrow key until IDE Mode is selected.

NOTE
When you first press the right arrow key, a message opens to warn you 
that changing SATA emulation may prevent access to the hard drives and 
degrade or corrupt the current volumes. Press Enter to close the 
message.

c. When IDE Mode is displayed, press F10 to accept the change. The Storage 
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Options window closes, and you return to the Storage menu.

6. Select Storage > Boot Order and press Enter.

The Boot Order window opens.

7. Verify the boot devices listed under Legacy Boot Sources are in the following order:

 ATAPI CD/DVD Drive

 Hard Drive

 SATA0

 USB Hard Drive

 USB Floppy/CD

 Network Controller

NOTE
The GE configuration for the rp5800 does not use EFI boot sources.

8. Do one of the following:

 If the boot order is correct, press Esc to close the Boot Order window without 
making any changes.

 If the boot order is incorrect, do the following:

a. Press the down arrow key to move the cursor to the boot device to be moved.

b. Press Enter to select the boot device.

c. Press the up and down arrow keys to move the selected boot device to the 
correct position in the list.

d. When the boot device is in the correct position, press Enter to deselect it.

e. Repeat step a through step d until all the boot devices are in the correct order.

f. When the boot order is correct, press F10 to accept the changes. The Boot 
Order window closes, and you return to the Storage menu.

9. Select File > Save Changes and Exit and press Enter to save your changes.

The Save Changes and Exit window opens and prompts you to confirm that you want to 
save your changes and exit the setup utility.

10. Select Yes and press Enter.

Your changes are saved, the Hewlett-Packard Computer Setup utility closes, and the 
system reboots. Proceed to “Loading the Image”.
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Loading the Image

Use the following procedure to load the factory image onto the HP rp5800 platform.

1. Insert the image media into the MARS platform’s optical drive.

Windows XP image part number: 2070506-002.

2. Reboot the computer.

The system boots to the MARS RP5800 System Image screen, which warns you that 
you are about to permanently overwrite the contents of the hard drive and asks if you 
want to continue.

3. Press Y.

The image begins to load onto the computer. When it is done, it verifies the image was 
applied successfully and displays the following status message:

Imaging Results:
Cloning: Success
CRC Check: Success

4. Remove the image CD from the optical drive.

5. Proceed to “Configuring the Operating System”.

Configuring the Operating System

Use the following procedure to configure the Windows XP Professional operating system on 
client platforms running the MARS v7 application.

1. Reboot the computer.

When the computer reboots, the Windows XP Professional Setup window opens.

2. Click Next.

A license agreement window opens.

3. Select the I accept this agreement option and click Next.

The Your product key window opens.

4. Enter the product key, found on the Windows label attached to the MARS computer, and 
click Next.

The system performs a series of setup tasks. When the setup tasks are complete,the 
computer reboots and the Logon window opens with the Administrator user account 
selected by default.

5. Enter the Administrator’s password and click OK.

The Windows desktop opens.

NOTE
If you do not know the password for the Administrator, contact Technical Support.

6. Verify the Windows desktop opened without error.

7. Verify the system’s date and time settings are correct.
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If the date and time settings are incorrect, adjust them accordingly. Refer to Windows 
Help for instructions on changing the system date and time, if necessary.

8. Proceed to “Activating the Operating System”.

Activating the Operating System

Use the following procedure to activate your Windows XP system.

1. From the Windows desktop, select Start > Activate Windows.

The Activate Windows window opens.

2. Select the appropriate activation option.

 To activate Windows over the Internet, select Yes, let’s activate Windows over the 
Internet now.

 To activate Windows over the telephone, select Yes, I want to telephone a 
customer service representative to activate Windows.

3. Click Next and follow the on-screen instructions to complete the activation.

4. When the activation is complete, proceed to “Installing the Modem Drivers” on page 14.

Installing the Modem Drivers

The HP rp5800 ships with the Multitech MT9234ZBA modem. The drivers for this modem are 
included in the system images. You do not need to do anything further to install drivers for this 
modem.

Installing Required Service Packs

Hewlett-Packard rp5800 systems are imaged using the most current service packs available 
at the time of shipment. Additional service packs should not be needed.

At the time of publication, the images included the following operating systems and service 
packs:

Applying Computer Names

The re-imaging process assigns a default computer name to the computer and assigns it to a 
workgroup. You need to reassign the original computer name and, if necessary, join the 
computer the same domain it was on before. Failure to reassign the computer’s original name 
and domain, especially on MARS servers, can create connectivity issues with MARS clients, 
MARS web clients, and the Morpheus Hx server, if those systems are in use at the site.

Image Part Number Operating System Service Packs

2070506–002 Windows XP Professional SP3
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Reinstalling the MARS Application

You are now ready to reinstall the MARS application. Proceed to “Re-installing the MARS 
Application” on page 21 for instructions.

Re-imaging Earlier Platforms

This section explains how to reimage the MARS Holter Analysis System on the following 
platforms: Compaq EVO D510, HP EVO D530, HP dc7100, and HP dc7600. If you have an 
earlier system, refer to the Service Manual that accompanied the system for instructions on 
re-imaging the system. 

The procedure for re-imaging earlier MARS systems is essentially the same for standalone, 
client, and server systems. Differences in the process due to platform or system roles are 
noted. The procedure consists of the following basic steps:

1. Changing the system boot sequence.

2. Loading the image.

3. Configuring the operating system.

4. Configuring the UPS.

5. Configuring pcAnywhere.

Applies only for the Compaq EVO D510 and HP EVO D530 systems.

6. Resetting the system boot sequence. 

Changing the Boot Sequence

Use the following instructions to change the sequence in which the system searches for 
bootable devices. This is necessary to ensure that the system can boot from the MARS 
Image CD. 

1. Insert the appropriate MARS Image CD. 

2. Reboot the system.

3. During the reboot, press and hold F10 to enter the BIOS setup.

4. Enter the system password if prompted.

If you do not know the password, contact technical support for assistance. 

5. When prompted to select a language, select English and press Enter.

The BIOS setup window opens.

6. Select Storage > Boot Order.

A list of valid boot devices, listed in the sequence in which the system will read them, 
opens.

7. Verify the boot order is as follows:

ATAPI CD-ROM
Hard Drive

If any other device is included, or if the order is different, change the order to match 
accordingly.
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8. Press F10 to accept the changes. 

9. Select File > Save Changes and Exit. 

The system reboots. You are now ready to load the MARS platform image. 

Loading the Image

Use the following procedure to load the factory image onto the platform. 

1. Insert the image CD into the MARS platform’s CD-ROM drive.

2. Boot or reboot the computer. 

The system boots to a command prompt asking if you want to image the computer.

3. Press Y. 

A command prompt appears asking you to confirm your selection.

4. Press Y. 

The image begins to load onto the computer. When it is done, it will verify the image was 
applied successfully and display a status message. 

NOTE
Both prompts are timed for 15 seconds. If you do not press a key within that time, 
the prompt will time out and you will return to root prompt. If this occurs, type clone 
and press Enter to run the re-imaging process. 

5. Remove the image CD and reboot the computer. 

You are now ready to configure the operating system. 

Installing MultiTech MT9234ZA Modem Driver

Refer to the MultiTech Modem MT9234ZBA Driver Installation Instructions (PN 2046472-001) 
to install the MultiTech MT9234ZBA Modem Driver, if applicable. This step is not needed if 
you have a MT5634ZBA modem.

Configuring the Operating System 

When you boot the operating system for the first time after loading the image, the operating 
system runs through a setup process that allows you to accept the license agreement and 
configure the operating system. 

1. If necessary, boot or reboot the MARS system. 

The log on window opens. 

2. Enter your Username and Password and press Enter. 

If you do not know the username or password, contact technical support. In the United 
States, this would be the Jupiter Remote On-Line Center at 1-800-558-7044. Outside of 
the United States, refer to “How to Reach Us…” at the beginning of the manual.

After you log on, the system begins to finish the installation process. Several screens will 
flash to indicate the current status. When this is done, a License Agreement window 
opens.

3. Select I accept this agreement and click Next.
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The Regional Settings window opens. 

4. Click Next.

The Personalize Your Software window opens. 

5. Complete the Name and Organization fields with the customer’s organization 
information and click Next.

The Product Key window opens. 

6. Enter the 25 digit product key located on the Microsoft label on top of your system and 
click Next.

The Computer Name and Administrator Password window opens. 

7. Enter a unique Computer Name and administrator password and click Next. 

The Modem Dialing Information window opens. 

NOTE
No other computer on the network can have the same computer name. 

If you do not know what administrator password should be, contact technical 
support. 

8. If you are rebuilding a standalone system with an attached modem, answer each 
question on the Modem Dialing Information window and click Next. 

The Date and Time Settings window opens. 

9. Enter the correct date and time, select the correct time zone, and click Next. 

The Network Settings window opens. 

10. Select Typical Settings and click Next.

The Workgroup or Computer Domain window opens. 

11. Select No, this computer is not., type MARSWORKGROUP, and select Next. 

A setup summary window opens. 

12. Click Finish to reboot the system.

Upon reboot, the Welcome to the Network Identification wizard opens. 

13. Click Next.

The Users of this Computer window opens. 

14. Select Users must enter... and click Next.

A summary window opens. 

15. Click Finish.

The log on prompt opens. 

16. Enter the Username and Password and click OK. 

If you do not know the username and password, contact technical support for 
assistance. 

You should now be logged on to the operating system and ready to continue with the 
rest of the system configuration. 
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Configuring the UPS

Some systems will be operated WITH a Uninterrupted Power Supply (UPS), and some will be 
operated WITHOUT a UPS. In either case, you must configure the system to work 
accordingly. 

Disabling the UPS Software
If you are setting up a machine WITHOUT a UPS, use the following instructions to disable the 
UPS software:

1. Click Start > Programs > Startup. 

2. Right-click on LSIII Executor and select Delete.

3. Click Yes to confirm the file deletion.

4. Right-click on the My Computer icon on the desktop. Select Manage.

5. Expand Services and Applications.

6. Click on Services.

7. Locate and right-click on LanSafe III Power Monitor Service. Select Properties.

8. Select Disabled for Startup Type.

9. Click OK.

10. Close the Computer Management window.

Reinstalling UPS Drivers
If you are setting up a machine WITH a UPS, use the following instructions to reinstall the 
UPS drivers:

1. If the Found New Hardware Wizard opens when you log on, click Next.

2. Insert the MARS Support CD in the CD-ROM drive. 

3. At the Install Hardware... screen, verify the device is a Powerware UPS and click Next.

4. At Locate Driver Files screen, click Next.

5. Verify that the Windows found a driver for this device... message is displayed. Click 
Next.

6. At the Lansafe III Setup dialog, click Yes.

7. Note that the LanSafe III Setup window appears. Click Install.

8. In the Introduction to UPS Groups window, select No and click Continue.

9. In the UPS model selection window, verify Powerware 5115 is selected. Click Continue.

10. In the Communication Port Selection window, verify that COM 1 is selected. Click 
Continue.

11. In the UPS Access Code window, type in WERIOP and click Continue.

12. In the Shutdown Timing Options window, leave default options and click Continue.

13. In the Install Path window, leave the default path and click Continue.

14. A window appears saying that the software was successfully installed. Click OK.

15. Click Finish.
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Configuring pcAnywhere v11.5

If you are rebuilding the Compaq EVO D510 or HP EVO D530, use the following instructions 
to configure pcAnywhere. 

NOTE
For dc7100 and dc7600 systems, skip to “Resetting the Boot Sequence” on page 6-19. 

1. From the Windows desktop, double-click the Symantec pcAnywhere icon on the 
desktop.

The Symantec pcAnywhere window opens.

2. Select Edit > Preferences.

3. On the Host Operation tab, select Windows Computer Name.

4. On the Remote Operation tab, adjust the Video Quality slide to 100.

5. For the Color scale select 256 colors.

6. Select Use pcAnywhere cache file and Optimize desktop for remote control.

7. Click OK.

8. Close the pcAnywhere Manager window.

g. To restart the system, select Start > Shutdown > Restart.

NOTE
For the next step, do NOT select Apply.

 Select Yes > OK.

9. If you are rebuilding a standalone workstation go to step 5. If you are building a client 
workstation, do the following:

a. Select the modem in the pcAnywhere Manager window.

b. Right-click Delete.

c. Click Yes to confirm the deletion.

10. Close the window.

11. Select Start > Shutdown > Restart.

Resetting the Boot Sequence

When you are done re-imaging your platform, use the following instructions to change the 
boot order of the pc.

1. Reboot the system.

2. During the reboot, press and hold F10 to enter the BIOS setup.

3. Enter the system password if prompted.

If you do not know the password, contact technical support for assistance. 

4. When prompted to selected a language, select English and press Enter.

The BIOS setup opens.

5. Select Storage > Boot Order.
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A list of valid boot devices, listed in the sequence in which the system will read them, 
opens.

6. Verify the boot order is as follows:

ATAPI CD-ROM
Diskette Drive
Hard Drive
USB Devices
Ethernet Controller

If any other device is included, or if the order is different, change the order to match 
accordingly.

7. Press F10 to accept the changes. 

8. Select File > Save Changes and Exit. 

The system reboots. You are now ready to re-install the MARS application. Refer to “Re-
installing the MARS Application” on page 6-21.
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Re-installing the MARS Application

The process for re-installing the MARS Holter Analysis System application software is nearly 
identical regardless of the hardware platform or software version. Minor differences do exist 
depending on whether the you are re-installing a standalone system, a client, or a server. 
Those differences are noted where appropriate.

In addition, if you are rebuilding a client system, you must uninstall the modem after re-
installing the application.

Re-installing the Application Software

Use the following instructions to install the MARS application software.

1. Insert the system’s dongle into a USB port. 

If the dongle is not inserted, the software will not install. 

2. Insert the MARS Holter Analysis Application CD into the CD drive.

The setup program starts automatically and the Choose Setup Language window opens. 

NOTE
If the installation does not start automatically, open Windows Explorer, browse to 
the root directory of your CD drive, and double-click setup.exe. 

3. Select the desired language at the Choose Setup Language window and click Next.

The Welcome to the InstallShield Wizard for MARS window opens. 

4. Click Next.

The License Agreement window opens. 

5. Read the license agreement and click Yes.

The Installation Mode window opens. 

6. Click the Install MARS PC button. 

The MARS Install window opens. 

7. Click the Typical Install (Recommended) button.

The MARS System Type window opens.

8. Select the type of system you are rebuilding. 

 To rebuild a standalone system, click the Standalone button.

 To rebuild a client system, click the Client button. 

 To rebuild a server, click the Server button. 

The Server button is only available if you re-imaged the platform using the server 
image. If you used the standalone/client image, the button will be grayed out. 

The Destination Disk window opens. 

9. Select the check box for the desired drive and click Next.
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You may select any of the drives listed in the Destination Disk window. If a drive does not 
have enough space available the “Not enough free space” message will appear next to 
the drive.

If you selected Standalone or Server systems, the Number of Patient Slots window 
opens. Proceed to step 10.

If you selected a Client system, the OmniDriver Setup window opens. Skip to step 12.

10. On the Number of Patient Slots window, enter the desired number of SEER and Tape 
slots by clicking on the arrows to the right of each field.

The minimum number of slots must 5. Enter the fewest number of slots you intend to 
use. System performance decreases as the number of slots increases. Refer to “Slot 
Installation/Time Consumption Report” on page B-3 for specific information.

11. Click Next.

The OmniDriver Setup window opens.

12. Select the appropriate driver for your system and click Next. 

 If your system has an internal card reader, select OmniDrive Professional. 

 If your system has an external card reader, select OmniDrive USB Professional. 

The Startup window opens. 

13. Select the desired option and click Next. 

 If running only MARS Holter Analysis software, select the Start MARS automatically 
at login option.

 If also running CardioSoft, select the Do not start MARS automatically at Login 
option.

The MARS Holter Analysis software installation begins. It takes approximately 5 – 15 
minutes to install, depending on the number of slots being created. When it is complete, 
the Install Shield Wizard Complete window opens. 

14. Remove the CD from the drive and click Finish. 

The MARS Holter Analysis system will reboot.

15. Store the CD in a safe location.

16. Do one of the following:

 If you installed the client software, proceed to “Uninstalling the Modem on Client 
Systems” on page 6-22.

 If you installed standalone or server software, skip to “Restoring MARS 
Configuration and Activator Codes” on page 6-26.

Uninstalling the Modem on Client Systems

If you are setting up a MARS Holter Analysis client system, you need to uninstall the modem. 

1. Open the Windows Control Panel and double click the Phone and Modem Options icon. 

The Phone and Modem Options window opens.

2. On the Modems tab, highlight the appropriate modem model and click Remove.
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You are prompted to confirm the deletion. 

3. Click Yes.

4. Click OK to close the Phone and Modem Options window.

5. Double click the Symantec pcAnywhere icon on the desktop.

The pcAnywhere Manager window opens. 

6. Click the Hosts button.

The Hosts window opens. 

7. Right-click the MODEM icon and select Properties.

The Modem Properties window opens. 

8. On the Settings tab, deselect Launch with Windows and click OK.

The Modem Properties window closes and returns to the Hosts window. 

9. Right-click the DIRECT icon and select Properties.

The Direct Properties window opens. 

10. On the Settings tab, select Launch with Windows and click OK.

If you are rebuilding a dc7100 or dc7600 platform, a dialog box may appear stating that 
another connection has already been selected to launch with Windows and asking if you 
would rather use this connection instead. Click Yes. 

If you are rebuilding any other platform, or after you answer Yes to the dialog box, the 
Direct Properties window closes.

11. Close the Hosts and pcAnywhere Manager windows.

12. Go to “Installing an External Card Reader” on page 6-24.
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Installing an External Card Reader

The dc7100, dc7600, and dc5750 platforms may come with an external USB OmniDrive card 
reader. Before the reader can be used, you must set up your system accordingly. 

NOTE
If you are not rebuilding a dc7100 or dc7600, skip to “Increasing the Number of Installed 
Licenses” on page 6-25.

If the external card reader is attached to the system when you boot up, it will be installed 
automatically and the Found New Hardware window will open. If the card reader was 
assigned any drive letter other than O:\, use the following instructions to change it. 

1. From the Windows desktop, right-click on the My Computer icon and select Manage.

The Computer Management window opens. 

2. Click on Disk Management.

A list of attached disk drives appears in the right-hand pane. 

3. Right-click on Disk 1 Removable and select Change Drive Letter.

The Change Drive Letter window opens. 

4. Select the drive letter for Disk 1 and click Change….

The Change Drive Letter dialog box opens. 

5. From the Assign the following drive letter field, select O: and click OK. 

A dialog box opens to warn you that some programs may not work if you change the 
drive letter and to ask if you want to continue. 

6. Click Yes.

7. Close the Computer Management window.
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Increasing the Number of Installed Licenses

If you are rebuilding an enterprise server with 25 clients, use the following instructions to 
increase the number of installed Windows Client Access Licenses from 5 to 25:

NOTE
If you are rebuilding a standalone or client system, skip to “Restoring MARS 
Configuration and Activator Codes” on page 6-26.

1. Select Start > Programs > Administrative Tools > Licensing.

The Enterprise Licensing window opens. 

2. On the Product View tab, click Windows Server.

3. Select License > Properties.

4. On the Server Browser tab, double-click on the name of this server.

The Properties of Windows Server window opens. 

5. Click Edit.

The Per Server Licensing window opens. 

6. Verify that Per Server licensing mode is selected and click Add License.

The New Client Access License window opens. 

7. Verify that Windows Server is selected for Product.

8. Enter 20 for Quantity and click OK.

The New Client Access License window closes and returns to the Per Server Licensing 
window.

9. Select I Agree that. and click OK.

The Per Server Licensing window closes and returns to the Properties of Windows 
Server window.

10. Click OK.

The Properties of Windows Server window and returns you to the Enterprise Licensing 
window.

11. Close the Enterprise Licensing window.
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Restoring MARS Configuration and Activator Codes

This step restores the system configuration and activator codes from the backup created in 
“Backing Up Configuration and Activator Codes” on page 6-4.

1. Launch the MARS application.

2. Place the backup medium into the appropriate drive.

3. Select System > System Setup > Backup and Restore.

4. Select the Restore Systems Setups check box.

5. Select the Restore activator codes check box (if the system setup includes activator 
codes).

6. Click Apply.

7. Select the appropriate drive from the Open window.

8. Select the xxx.mars file and click Open.

(Where xxx is the file name created at time of the backup.)

9. Click Yes at the prompt, You are about to restore the following backup.

10. Click OK at The restore completed successfully message. 

The MARS application closes automatically.

11. Remove the backup medium.

If the system you rebuilt runs on the Windows 2000 operating system, continue with “Setting 
the Language” on page 6-27. Otherwise, skip to “Installing SEER Light Hookup” on 
page 6-28.
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Setting the Language

The MARS Holter Analysis system is set to English at the factory, but it provides additional 
support for Chinese (simplified), Danish, Dutch, French, German, Italian, Japanese, 
Norwegian, Russian, Spanish, and Swedish. 

Setting the Application Language

Use the following procedure to change the language if the order calls for a non-English 
language. If the order is for English, skip to “Installing SEER Light Hookup” on page 6-28. 

1. Log on to the MARS system.

2. Run the MARS application. 

3. Select System > System Setup > Language.

4. Select the desired language.

5. Click Save Changes. 

6. When prompted to confirm the change, click OK. 

7. Close and restart the MARS application. 

8. Verify the application is displayed in the correct language. 

If the language does not display properly, skip to “Setting the Operating System 
Language” on page 6-27. 

9. Proceed to “Installing SEER Light Hookup” on page 6-28:

Setting the Operating System Language

If the order is for a non-Unicode language (such as Russian, Japanese, and Simplified 
Chinese), the language may not display properly in the MARS application unless the 
language is also selected at the OS level. Use the following instructions to change the OS 
language.

1. From the MARS desktop, select Start > Settings > Control Panel > Regional and 
Language Options.

2. On the Advanced tab, select the appropriate language in the Language for Non-Unicode 
Programs drop down list. 

3. Click Apply.

4. When prompted to confirm the selection, click Yes.

5. When prompted to restart your system, click OK. 
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Installing SEER Light Hookup

If the MARS Holter Analysis System will be used in conjunction with a SEER Light Connect 
device, use this task to install the software before you connect the device to the system. 

To install the software, you must have administrator privileges and the system must be 
running Windows 2000, 2000 Server, XP, or 2003 Server. You cannot install the software on 
Windows NT, 98, or ME. 

NOTE
If the MARS Holter Analysis System will not be used in conjunction with a SEER Light 
Connect device, skip this task. 

1. Insert the SEER Light Hookup software CD in the workstation’s CD-ROM drive.

The SEER Light Hookup InstallShield Wizard opens. 

2. Select the appropriate language and click Next.

072A

The SEER Light Hookup Setup welcome window opens. 

3. Click Next.
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073A

The License Agreement window opens.

4. Review the license agreement and click Yes.

The Destination Disk window opens. 

5. Highlight the disk in which the SEER Light Hookup application will be installed and click 
Next.

074A

The software begins installing. When it is finished, a message appears asking if you 
would like to view the installation report.

6. Do one of the following. 

 To continue without reviewing the installation report, click No.

The InstallSheild Wizard Complete window opens. Skip to step 8.

 To review the installation report, click Yes. 

The Installation Report opens. Continue to step 7.
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076A

7. Review the report as necessary.and do any of the following

 To print the report, select the Print button. 

 To view previous installation reports, select the View History button. This button will 
be grayed out if no prior installations were done on your computer.

 To close the Installation Report, click Next.

The InstallSheild Wizard Complete window opens. 

8. Select Yes, I want to restart my computer now and click Finish. 

The computer reboots.

9. Log in as Administrator. 

10. Plug one end of a USB cable into a USB port of your computer and the other end to the 
SEER Light Connect device.

One of two things happens depending on the operating system. 

 If you are on a Windows 2000 operating system, the Insert Disk window opens. 
Proceed to step 11.

 If you are on a Windows XP operating system, the Found New Hardware Wizard 
window opens. Skip to step 14.

11. Select OK.

078A

Two additional files (WinRTUSB.dll and WinRTUSB.sys) need to be loaded. The Files 
Needed window opens. 

12. In the dropdown box, type in D:\drivers\ (or the letter assigned to the CD drive if it is not 
D) and click OK.
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079A

The Files Needed window opens again.

13. In the dropdown box, type in D:\drivers\ (or the letter assigned to the CD drive if it is not 
D) and click OK. 

The SEER Light Hookup installation for Windows 2000 systems is now complete. 

14. On the Found New Hardware Wizard window, select Install the software automatically 
and click Next.

082A

The Found New Hardware Wizard window opens again. 

15. Click Finish.
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083a

The SEER Light Hookup installation for Windows XP systems is now complete.
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System Checkout: Checkout Procedure
Checkout Procedure 

Verify the MARS™ Holter Analysis System operates correctly by following 
the system checkout procedure. Have the MARS Holter Analysis workstation 
and OEM manuals available for reference.

Not all checkout tasks apply to each MARS Holter Analysis configuration. 
For example, not all systems will have a tape acquisition unit, and 
standalone systems will not have a MARS Holter Analysis server. Perform 
only the tasks appropriate for your configuration, but perform the tasks in the 
order in which they appear.

NOTE
For MARS Holter Analysis systems running Windows NT, use the 
checkout procedure located in the service manual that shipped with the 
unit. Afterward, use the “Testing Network Connectivity” on page 7-8 of 
this manual to verify the network connections.

Shutting Down the System 

To prevent loss of data or damage to the workstation during the checkout, 
follow the “Safe Shutdown Procedure” on page 4-5 before proceeding with 
the checkout.

Logging on to the Workstation

1. Turn on the workstation.

2. Turn on the monitor. 

3. Watch for error messages.

If you receive any error messages, stop the checkout procedure and 
contact MARS™ Holter Analysis System technical support.

4. Turn on any local parallel printer connected to the workstation.

5. Press Crtl + Alt + Delete to open the logon window.

6. Enter your User Name and Password.

Contact the MARS Holter Analysis Workstation Technical Support Line if 
you do not know the User Name and Password.

7. Click OK.

8. Watch for error messages.

If you receive any error messages, stop the checkout procedure and 
contact MARS™ Holter Analysis System technical support.
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Backing Up Configuration and Activator Codes

1. Follow the procedure in “Backing Up Configuration and Activator Codes” 
on page 6-4 to back up the configuration and activation codes to a floppy 
disk. 

2. From the MARS application, select Help > About to view the serial 
number of the MARS™ Holter Analysis System.

3. Write the serial number on the floppy disk and store it in a safe location.

Acquiring Patient Data

Verify that patient data can be acquired. Refer to the MARS Holter Analysis 
Workstation Operators Manual for information on acquiring patient data.

Printing a Patient Report

1. Select Patient Select.

2. Choose a patient.

3. Select Report Review.

4. Select Print Page.

If the report does not print, stop the checkout procedure and contact the 
MARS™ Holter Analysis System technical support line.

Refer to the MARS™ Holter Analysis System Operator’s Manual for 
more information on printing patient reports.

Archiving Patient Data

If you have a CD-RW or DVD-RW drive, verify that you can archive patient 
data to a CD or DVD. Refer to the MARS™ Holter Analysis System 
Operators Manual for information on archiving patient data.

Testing the Tape Acquisition Unit

Tape acquisition units are not available on NT, dc7600, or dc5750 systems.

1. Confirm that the SCSI ID switch on the back of the unit is set to 5. 

NOTE
If the SCSI ID is set incorrectly, adjust the setting and reboot the 
workstation.

2. Verify the unit can read, display, and print information from a Holter tape. 
Refer to the MARS Holter Analysis Workstation Operators Manual for 
more information on using a tape acquisition unit. 
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Testing Remote System Support

1. Verify the modem did not issue any error messages. 

2. Identify the phone number of the analog telephone line attached to the 
modem. 

3. Call MARS™ Holter Analysis System Technical Support with the 
telephone number and request a RSS link to verify remote access. 

Testing the Backup Power Source

A backup power source is provided with each MARS™ Holter Analysis 
System. It may be an uninterruptible power supply (UPS) or an isolation 
transformer (IT), depending on the workstation’s hardware model. The 
procedure for testing the backup power source depends on which unit is 
provided. 

Identify the manufacturer from the front of the unit and refer to the following 
table for instructions on where to turn for testing instructions. 

Testing an ONEAC IT 

1. Perform the tasks in the following table and verify the results. 

2. Do one of the following, depending on whether the workstation is 
connected to the network:

 If it is, go to “Testing Network Connectivity” on page 7-8.

 If it is not, the checkout is complete.

If the manufacturer is… turn to…

ONEAC “Testing an ONEAC IT” on page 7-5

Powerware “Testing a Powerware UPS” on page 7-6

APC “Testing an APC UPS” on page 7-6

Task Verify

Detach the serial cable 
from the unit

You receive a message that a power failure occurred 
and the computer will shut down in one minute.

Re-attach the serial cable 
to the unit

You receive a message that the power failure has 
been resolved and the shutdown has been canceled. 

Unplug the workstation 
from the wall outlet

 You receive a warning beep and a message that 
the computer is on battery power and will be 
shutdown in 10 minutes.

 The warning beep sounds every minute.
 The time in the shutdown message updates 

accordingly each minute.
 The system shuts down after 10 minutes. 
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Testing a Powerware UPS

1. Perform the tasks in the following table and verify the results. 

2. Do one of the following, depending on whether the workstation is 
connected to the network:

 If it is, go to “Testing Network Connectivity” on page 7-8.

 If it is not, the checkout is complete.

Testing an APC UPS

The MARS™ Holter Analysis System is provided with one of two APC UPS 
models. The procedure for testing an APC UPS unit depends on the unit’s 
model. 

Locate the model number on the back of the unit and refer to the following 
table for the appropriate test instructions. 

Task Verify

Detach the serial cable 
from the UPS

You receive a message indicating a communication 
failure with the UPS.

Re-attach the serial cable 
to the UPS

You receive a message indicating that 
communication has been established with the UPS.

Press and hold the test 
button on the front of the 
UPS

You receive the following messages:
 Utility power failure... MARS Holter Analysis is on 

battery...shutdown in 5 minutes.
 Message from MARS Holter Analysis to 

WORKGROUP on...MARSPC is on 
battery...shutdown in 5 minutes.

Release the test button You receive the following messages:
 Utility power failure resolved... MARS Holter 

Analysis shutdown has been cancelled.
 Message from MARSPC to WORKGROUP 

on...MARSPC shutdown has been cancelled

Unplug the workstation 
from the wall outlet

You receive the following messages:
 Utility power failure... MARS Holter Analysis is on 

battery...shutdown in 5 minutes.
 Message from MARS Holter Analysis to 

WORKGROUP on...MARSPC is on 
battery...shutdown in 5 minutes.

The system shuts down after 5 minutes. 

If the model is… refer to…

BK500MC “Testing Model BK500MC” on page 7-7.

BK500MI “Testing Model BK500MI” on page 7-8
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Testing Model BK500MC

1. On the workstation desktop, select Start > Programs > Parachute plus > 
Parachute plus.

2. On the Monitor Server window, select Attach.

3. When the following window appears, verify the unit is monitoring the 
correct system name and that its status is On Line. 

4. On the UPS unit, press the test button, hold it for approximately 3 
seconds, and verify the following: 

 A warning beep sounds. 

 The status changes to On Battery. 

 The following message displays: <Computer name> is running on 
battery power. <Computer name> will shut down in xxx minutes and 
xxx seconds.

5. Release the test button and verify the following: 

 The status changes to On Line. 

 The following message displays: Normal utility power at <computer 
name> has been restored.

6. Close all windows and do one of the following, depending on whether 
the workstation is connected to the network:

 If it is, go to “Testing Network Connectivity” on page 7-8.

 If it is not, the checkout is complete.

11A
2020044-065J MARS™ Holter Analysis System 7-7



System Checkout: Checkout Procedure
Testing Model BK500MI

1. Disconnect the UPS AC power inlet cord and verify the following.

 A warning beep sounds every 5 seconds.

 The power light is lit on the front of the Compaq system.

2. Reconnect the UPS AC power inlet cord. and do one of the following, 
depending on whether the workstation is connected to the network:

 If it is, go to “Testing Network Connectivity” on page 7-8.

 If it is not, the checkout is complete.

Testing Network Connectivity 

This procedure cannot be performed for standalone workstations with no 
network connections. Some steps may not apply in all configurations.

NOTE
Before starting, know the server’s computer name and IP address. If 
necessary, select System > System Setup > Network to view the 
server’s computer name. See “Network Setup for Clients” on page 3-5 
for more information.

1. On a workstation, open a DOS Command window.

2. Type ping [space] <computer name> (where <computer name> is the 
name of the server) and press Enter. 

3. Verify the following:

 The workstation can connect to the server.

 The connection does not time out.

 The correct IP address is returned.

4. Within the MARS Holter Analysis application, click the Patient Select 
icon.

NOTE
If you can ping the MARS Holter Analysis server but can’t access 
the Patient Select option, confirm that the network drive share 
permissions are correct. 

5. Within the application, verify you can perform the following:

 Print a patient strip review from the workstation and server.

 View the server patient list from the workstation.

 Select and edit a patient file from the MARS Holter Analysis server.

 Store a patient report from the workstation or server to MUSE. 
(Applicable only if the MARS to MUSE option is enabled.)

NOTE
If you delete a report at the MARS Holter Analysis workstation, the 
report will be removed from the list.

The network checkout is complete when the tests are done.
7-8 MARS™ Holter Analysis System 2020044-065J



8 Parts List
2020044-065J MARS™ Holter Analysis System 8-1



For your notes
8-2 MARS™ Holter Analysis System 2020044-065J



Parts List: Introduction
Introduction

Ordering Parts

The parts list in this chapter lists all the FRU items that may need to be ordered. If 
you need any additional information or troubleshooting assistance please contact the 
Jupiter Remote On-Line Center at 1-800-558-7044. If you need technical support 
and you are not in the US, see “How to Reach Us...” at the front of this manual to 
determine who to contact for technical support.

To order parts please contact the Service Parts department at the address or 
telephone number listed on the “How to Reach Us” page provided at the beginning 
of this manual

Table 1. Systems and Images

GE Part Number Description Qty

2070506–002 DVD MARS rp5800 Windows XP Image 1

2008849-003 Compaq EVO D510 mini-tower system 1

2020338-001 HP EVO D530 CMT (convertible mini-tower) 1

2025413-001 HP dc7100 CMT (convertible mini-tower) 1

2025658-003 HP dc7100 Win2k Server image CDs 2

2025659-003 HP dc7100 Win2k Pro image CDs 2

2030407-001 HP dc7600 CMT (convertible mini-tower) 1

2025658-006 Kit MARS dc7600 Win 2003 server image CDs 1

2025659-006 Kit MARS dc7600 XP Pro image CDs 1

2037288-001 MARS DC5750 Server 2003 Image DVD 1

2037286-001 MARS DC5750 XP Image DVD 1

2044118-001 HP rp5700 Computer 1

2044120-001 DVD MARS RP5700 XP IMAGE 1

2044119-001 DVD MARS RP5700 SERVER IMAGE 1

Table 2. Compaq EVO D510 Mini Tower Internal System (GE Part Number 2008849-003) 

Compaq Part 
Number

GE Part Number Description Qty

250185-001 2008849-004 100/7200 ATA hard drive - 80Gb 1

286711-001 2008849-005 40/12/40X CD-RW drive 1

289983-001 2008849-006 Mother board 1
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305579-001 2008849-007 2.8GHZ CPU (533MHz front side bus, 512KB L2 cache, 478-pin 
socket)

1

285649-001 2008849-008 DDR DRAM 256 MB 1

302652-001 2008849-009 Serial ribbon cable 1

278644-001 2008849-010 Floppy diskette drive 3.5 1

153099-001 2008849-011 Battery 1

289575-001 2008849-012 Chassis fan assembly 1

283984-001 2008849-013 Internal serial port 1

299172-001 2008849-014 Front cover plastic panel 1

277979-001 2008849-015 Power supply dual voltage 1

257047-001 2008849-016 IDE ribbon cable 1

Table 2. Compaq EVO D510 Mini Tower Internal System (GE Part Number 2008849-003) (Continued)

Compaq Part 
Number

GE Part Number Description Qty

Table 3. HP EVO D530 CMT Internal System  (GE Part Number 2020338-001)

HP Part Number GE Part Number Description Qty

250185-001 2020338-003 100/7200 ATA hard drive - 80Gb 1

325308-001 2020338-004 48X/24X/48X CD-RW drive 1

323091-001 2020338-005 Mother board (does not include processor) 1

335813-001 2020338-006 2.8GHz CPU (533MHz front side bus, 512KB L2 cache, 478-pin 
socket)

1

335698-001 2020338-007 DDR SDRAM DIMM memory 256 MB 1

333505-001 2020338-008 Floppy diskette drive 3.5 1

153099-001 2020338-009 Battery 1

330457-001 2020338-010 Chassis fan 1

341899-001 2020338-011 Internal serial port 1

336443-001 2020338-012 Front cover plastic panel 1

308615-001 2020338-013 Power supply 1

336448-001 2020338-014 IDE cable-Ultra ATA dual device 1
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Table 4. HP dc7100 CMT Internal System (GE Part Number 2025413-001) 

HP Part Number GE Part Number Description Qty

345713-005 2025413-003 100/7200 ATA hard drive - 80Gb 1

358688-001 2025413-004 8x DVD+R/+RW drive 1

365865-001 2025413-005 Mother board (does not include processor) 1

367594-001 2025413-006 2.8GHz CPU (800MHz front side bus, 1MB L2 cache, 478-pin 
socket)

1

335698-005 2025413-007 DDR SDRAM DIMM memory 256 MB 2

333505-005 2025413-008 Floppy diskette drive 3.5 1

153099-001 2025413-009 Battery 1

366641-001 2025413-010 Chassis fan 1

283984-005 2025413-011 Internal serial port 1

371116-001 2025413-012 Front cover plastic panel 1

344987-001 2025413-013 Power supply 1

366640-001 2025413-014 IDE cable-Ultra ATA dual device 1

Table 5. HP dc7600 CMT Internal System (GE Part Number 2030407-001) 

HP Part Number GE Part Number Description Qty

392405-001 2030505-002 Computer access panel dc7600 CMT 1

381023-001 2030505-003 Power supply PFC DC7600 CMT 1

391945-001 2030505-004 80 GB\7200 RPM SATA hard drive dC7600 1

390882-001 2030505-005 16X DVD+/-RW with lightscribe (DL/DF) DC7600 1

392286-001 2030505-006 IDE cable odd 17.25" two device dc7600 1

391738-001 2030505-007 SATA hard drive cable 13" DC7600 1

392285-001 2030505-008 Power switch/led cable without switch holder 1

392412-001 2030505-009 Chassis fan dc7600 1

392413-001 2030505-010 Speaker dc7600 1

382023-001 2030505-011 Heatsink with thermal grease and alcohol pad 1

336445-005 2030505-012 Rubber foot (4 ea.) dc7600 1

392414-001 2030505-014 Second serial port (full height) dc7600 1

380356-001 2030505-015 Sys board with alcohol pad and thermal grease 1
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396520-001 2030505-016 512 MB/667 MHz FSB dc7600 1

392273-001 2030505-017 3.0 GHz\800 MHzFSB 2MB cache 630 dc7600 1

Table 5. HP dc7600 CMT Internal System (GE Part Number 2030407-001) (Continued)

HP Part Number GE Part Number Description Qty

Table 6. HP dc5750 CMT Internal System (GE Part Number 2016184-006) 

HP Part Number GE Part Number Description Qty

432864-001 2036936-001 Front bezel assembly with 3.5-in. bezel blank and 5.25 in. bezel 
blank 

1

433124-001 2036936-002 Access panel 1

404795-001 2036936-003 Power supply, 300W 1

432392-001 2036936-004 80-GB\7200 RPM SATA hard drive, 8MB cache 1

432394-001 2036936-005 250-GB\7200 RPM SATA hard drive, 8MB cache 1

419498-001 2036936-006 16X SATA DVDRW L drive with LightScribe 1

439216-001 2036936-007 Diskette drive cable 1

391739-001 2036936-008 SATA HDD cable, 19.5-in. lg (2 straight ends) 1

393958-001 2036936-009 SATA HDD cable, 18-in. lg (1 straight, 1 angle end) 1

432862-001 2036936-010  Front I/O with USB, audio cables, power/LED cable, switch and 
switch holder 

1

432863-001 2036936-011 Chassis fan 1

430129-001 2036936-012 Internal speaker 1

335937-005 2036936-013 5.25-in bezel blank 1

432865-001 2036936-014 Heatsink with alcohol pad, factory-applied thermal grease, and 
heatsink shroud 

1

390937-001 2036936-015 Mouse, PS2, scroll type 1

153099-001 2036800-016 Battery, real-time clock 1

392414-001 2036936-017 Second serial port, FH 1

435529-001 2036936-018 Rear I/O panel 1

433123-001 2036936-019 Fan duct 1

432861-001 2036936-020 System Board with thermal grease, alcohol pad, and CPU socket 
cover- Standard board 

1

396520-001 2036936-021 512 MB, PC2-5300, CL5 1
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398038-001 2036936-022 1 GB, PC2-5300, CL5 1

435912-001 2036936-023 AMD Athlon64 processor with 1.0 GHz HyperTransport, 3800+, 
2.4 GHz, 512 KB cache, 2.0 GHz FSB 

1

Table 6. HP dc5750 CMT Internal System (GE Part Number 2016184-006) (Continued)

HP Part Number GE Part Number Description Qty

Table 7. FRUs, HP rp5700 Computer (GE Part Number 2044118-001) 

GE Part Number HP Part Number Description Qty

2044118-001 FZ429UP#ABA COMPUTER RP5700 MARS 1

2040746-001 445766-001 FRU RP5700 HOOD ASSY W FRT BEZEL 1

2040746-002 445771-001 FRU RP5700 POWER SUPPLY 1

2040746-003 445759-001 FRU RP5700 POWER SWITCH W LED AND CABLE 1

2040746-004 445768-001 FRU RP5700 SERIAL PORT W CABLE 1

2040746-005 440499-001 FRU RP5700 HD DRIVE 160GB 7200 RPM SATA 1

2040746-006 445757-001 FRU RP5700 SYSTEM BOARD 1

2040746-007 450470-001 FRU RP5700 CPU 2GB E6400 2.13GHZ 1

2036936-022 398038-001 FRU DC5750 1 GB, PC2-5300, CL5 1

2040746-008 445758-001 FRU RP5700 MEMORY RISER CARD 1

2040746-009 445775-001 FRU RP5700 USB EXPANSION CARD W CBL 1

2040746-010 445761-001 FRU RP5700 FAN 1

2040746-011 445774-001 FRU RP5700 HEATSINK 1

2040746-012 417966-001 FRU RP5700 MOUSE PS2 OPTICAL 1

2036800-016 153099-001 FRU HP ML370 3.3-V LITHIUM BATTERY 1

2040746-013 445766-001 FRU RP5700 FRONT BEZEL 1

2040746-014 445762-001 FRU RP5700 SPEAKER INTERNAL 1

2040746-015 445767-001 FRU RP5700 FAN DUCT 1

2040746-016 445770-001 FRU RP5700 TOWER STAND 1

2040746-017 RV629AV SATA 16X SUPERMULTI LIGHTSCRIBE ALL 1
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Table 8. HP rp5800 Computer 

GE Part Number HP Part Number Description Qty

2066875-002 653026-001 Access panel 1

2066875-003 653025-001 Front Bezel 1

2066875-004 628930-001 System Board, Trusted Platform Module
(TPM)

1

2066875-005 655580-001 System Board, non-TPM 1

2066875-006 659246-001 Power Supply 1

2066875-007 635803-001 RAM, 2–GB, HP 1

2066875-021 638629-001 Intel Core i3 2120 (3.3-GHz, 3-MB L3
cache, 65W)

1

2066875-008 655579-001 Front USB and power switch assembly 1

2066875-009 653023-001 Powered serial cable 1

2066875-013 638813-001 SATA cable, 19.5 inch, 2 straight ends 1

2066875-016 638814-001 SATA cable, 25.2 inch, 1 straight end, 1
angled end

1

2066875-017 603250-001 Adapter, Display Port to VGA 1

2066875-020 484156-001 Adapter, Display Port to DVI 1

2066875-030 617450-001 Adapter, Display Port to HDMI 1

2066875-031 487562-001 Display Port cable 1

2066875-032 653028-001 Cable cover 1

2066875-033 645326-001 Heat sink and replacement thermal
material

1

2066875-034 653024-001 Chassis fan 1

2066875-035 636925-001 Speaker 1

2066875-036 638817-001 Printer port, PCI card 1

2066875-037 636921-001 Fan duct 1

2066875-038 638946-001 Serial port (COMB) card 1

2066875-039 490689-001 Modem, LSI, v.92 1

2066875-012 645558-001 eSATA port assembly, PCI card 1

2066875-040 537745-001 PS/2, basic for use in the United States 1

2066875-041 609250-001 PS/2, basic 1

2066875-018 636927-001 Internal Hard Drive, 250-GB, 7200-rpm 1
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2066875-022 419496-001 16X SATA DVD-ROM drive 1

2066875-042 638947-001 2-port powered serial card 1

2066875-011 638944-001 PCIe to PCIe riser – 24V 1

2066875-043 638945-001 Powered USB card – 12V 1

2066875-010 637591-001 HP FireWire / IEEE 1394a PCIe x1 card 1

2066875-014 635523-001 Intel PRO/1000CT NIC, includes bracket 1

Table 8. HP rp5800 Computer 

GE Part Number HP Part Number Description Qty

Table 9. Printers

GE Part Number Description Qty

2008159-001 HP 1200 LaserJet printer 1

2014596-005 HP 4200N LaserJet printer 1

2025143-001 HP 4250N LaserJet printer 1

2037296-001 Ricoh SP 4100N Laser printer 1

2044121-001 PRINTER HP LASERJET P4015N 1

Table 10. Security Keys (Dongles)

GE Part Number Description Qty

2019278-001 Parallel port security key (dongle) 1

2019278-002 USB security key (dongle) 1

Table 11. Keyboards 

GE Part Number Description Qty

2016193-001 English keyboard 1

2016193-003 Danish keyboard 1

2016193-006 French keyboard 1

2016193-007 German keyboard 1

2016193-008 Italian keyboard 1

2016193-009 Norwegian keyboard 1

2016193-011 Spanish keyboard 1
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2016193-012 Swedish/Finnish Keyboard 1

2016193-029 Dutch keyboard 1

2016193-032 Chinese (simplified) keyboard 1

2016193-033 Japanese keyboard 1

2016193-036 Russian keyboard 1

Table 11. Keyboards (Continued)

Table 12. Compaq EVO D510 and HP EVO D530 OEM Hardware 

GE Part Number Description Qty

2008751-001 Adapter MARS compact flash to PC card 1

70124944 Internal PCMCIA card reader 1

2017036-001 Black bezel 3.5 to 5.25 (for card reader) 1

2016200-001 I/O serial board 1

2016199-001 I/O parallel board 1

2015936-001 SCSI board (optional) 1

2016502-001 Cable internal 1

Table 13. HP dc7100 OEM Hardware 

GE Part Number Description Qty

2015936-001 SCSI board (optional) 1

2025508-001 External OMNI USB linear flash card reader 1

2025507-001 Single external USB-serial RS232 connector cable 2

Table 14. Monitors

GE Part Number Description Qty

2000594-016 Compaq 17-inch monitor 1

2001732-002 Sony 21-inch Monitor CPD-G520P 1

2013547-001 NEC 1880SX flat panel display 18 inch 1

2030979-001 NEC 1990SXi flat panel display 19-inch 1

2040982-001 DSPL 19 IN LCD HP L1910 1

2040982-001 DSPL 19 IN LCD HP LE1911 1
8-10 MARS™ Holter Analysis System 2020044-065J



Parts List: Introduction
   

Table 15. SCSI Board for Tape Acquisition (Domestic) Kit PN 2026559-001
(not compatible with HP dc7600 CMT systems)

GE Part Number Item Description Qty

2015936-001 PCI ULTRA320 SCSI card 1

2010165-249 MARS SCSI board installation instructions 1

2005410-001 Interface cable SCSI 3M TO SCSI 2 1

413636-001 Terminator SCSI-2 MINI-50 SUN 1

900791-101 Kit MARS tape acquisition (with 110v internal power supply) 1

Table 16. SCSI Board for Tape Acquisition (International) Kit PN 2026559-002
(not compatible with HP dc7600 CMT systems)

GE Part Number Description Qty

2015936-001 PCI ULTRA320 SCSI card 1

2010165-249 MARS SCSI board installation instructions 1

2005410-001 Interface cable SCSI 3M TO SCSI 2 1

413636-001 Terminator SCSI-2 MINI-50 SUN 1

900791-102 Kit MARS tape acquisition (with 220v internal power supply) 1

Table 17. Peripherals 

GE Part Number Description Qty

2003771-002 Powerware PW5115, 500, 110V 1

2003772-003 Powerware PW5115, 500i, 230V 1

2030414-001 ONEAC PCm750J–C4CB VA Medical Grade
Power Conditioner

1

Powervar ABC600-11MED Medical Grade
Power Conditioner

2030414-002 ONEAC PCm750I–C4CB VA Medical Grade
Power Conditioner

1

Powervar ABC750-22MED Medical Grade
Power Conditioner

2046544-001 MultiTech Modem MT9234ZBA Replacement Kit 1

900466-101 Tape acquisition drive (US only) 1

900466-102 Tape acquisition drive (international) 1

2005410-001 SCSI cable 1
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2030414-001 Medical grade isolation transformer (120V) 1

2030414-002 Medical grade isolation transformer (220V) 1

2008595-009 SEER Light Connect Device (optional) 1

2027495-004 SD Card Reader Memory Card 18 in 1 1

2008099-002 Adapter CF to PC Card Type II 1

422187-001 OmniDrive Card Reader 1

Table 17. Peripherals (Continued)

Table 18. Miscellaneous

GE Part Number Description Qty

3613-902 Tape Cleaning and demagnetizer kit (used ontape acquisition unit) 1
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Table 1. Compaq EVO D510 Mini-Tower Workstation Specifications 

Manufacturer/Model Compaq EVO D510 Mini tower

Processor Intel Pentium 4 (1.8G/P4 CPU)

Standard L2 Cache 256 KB

System memory 2 GB (maximum)

Hard drive capacity 20 GB

Chipset Intel 845G

Front side bus 400 MHz

Number of serial ports 4

CD-ROM drive 16X CD-ROM Drive

Dimensions (H x W x D) 17.65 x 6.6 x 16.8 inches (44.8 x 16.8 x 42.7 cm)

Weight 26 lbs. (11.8 kgms)

Rated Input Voltage 100 to 127 VAC or 200-240 VAC

Rated Input Current 6A @ 100VAC/3A@ 220VAC

Maximum Rated Power 220W

BTU/hr 1061 BTU/hr Maximum (338W input)

Table 2. HP EVO D530 CMT (Convertible Mini-Tower) Workstation Specifications 

Manufacturer/Model HP EVO D530 CMT (Convertible Mini tower)

Processor Intel Pentium 4 (3.2G/P4 CPU)

Standard L2 Cache 512 KB

System memory 2 GB (maximum)

Hard drive capacity 80 GB

Chipset Intel 865G

Front side bus 533 MHz

Number of serial ports 4

CD-ROM drive 48X/24X/48X CD-RW Drive

Dimensions (H x W x D) 17.65 x 6.6 x 17.8 inches (44.8 x 16.7 x 45.2 cm)

Weight 32.5 lbs. (14.74 kgms)

Rated Input Voltage 100 to 127 VAC or 200-240 VAC

Rated Input Current 6A @ 100VAC/3A@ 220VAC

Maximum Rated Power 240W

BTU/hr 1260 BTU/hr Maximum
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Table 3. HP dc7100 CMT (Convertible Mini-Tower) Workstation Specifications 

Manufacturer/Model HP dc7100 CMT (Convertible Mini tower)

Processor Intel Pentium 4 (3.2G/P4 CPU) with Hyperthread

Standard L2 Cache 1MB

System memory 4 GB (maximum)

Hard drive capacity 80 GB

Chipset Intel 915G Express

Front side bus 800 MHz

Number of serial ports 2

DVD+R/+RW Drive 8X 4.7 GB DVD+R/+RW Drive

Dimensions (H x W x D) 17.65 x 6.6 x 17.8 inches (44.8 x 16.7 x 45.2 cm)

Weight 32.5 lbs. (14.74 kgms)

Rated Input Voltage 100 to 120 VAC or 200-240 VAC

Rated Input Current 6A @ 100VAC/3A@ 220VAC

Maximum Rated Power 340W

BTU/hr 1575 BTU/hr Maximum

Table 4. HP dc7600 CMT (Convertible Mini-Tower) Workstation Specifications 

Manufacturer/Model HP dc7600 CMT (Convertible Mini tower)

Processor Intel Pentium 4 (3.0G/P4 CPU) with Hyperthread

Standard L2 Cache 2MB

System memory 4 GB (maximum)

Hard drive capacity 80 GB

Chipset Intel 915G Express

Front side bus 800 MHz

Number of serial ports 1

DVD+R/+RW Drive 16X 4.7 GB DVD+R/+RW Drive

Dimensions (H x W x D) 17.65 x 6.6 x 17.8 inches (44.8 x 16.7 x 45.2 cm)

Weight 32.5 lbs. (14.74 kgms)

Rated Input Voltage 100 to 120 VAC or 200-240 VAC

Rated Input Current 6A @ 100VAC/3A@ 220VAC

Maximum Rated Power 340W

BTU/hr 1575 BTU/hr Maximum
A-4 MARS™ Holter Analysis System 2020044-065J



: 
  

Table 5. HP dc5750 MT (Mini-Tower) Workstation Specifications 

Manufacturer/Model HP dc5750 MT (Mini tower)

Processor AMD Athlon 64 3800+ (2.4 GHz)

Standard L2 Cache 512k

System memory 512 MB installed

Hard drive capacity 80 GB

Chipset ATI Express 1150

Front side bus 2 GHz

Number of serial ports 2

DVD+R/+RW Drive 16X 4.7 GB DVD+/-RW Drive

Dimensions (H x W x D) 14.85 in. x 6.95 in. x 16.85 in. (377mm x 177mm 428mm)

Weight 30.3 lbs. (13.74 kg)

Rated Input Voltage 100 to 127 VAC or 200-240 VAC

Rated Input Current 8A @ 100 VAC, 4A @ 220VAC

Maximum Rated Power 300W

BTU/hr 1575 BTU/hr Maximum

Table 6. HP rp5800 Sall Form Factor 

Component Description

Processor Type Intel® Core i3-2120, 2 cores/4 threads

Processor Speed 3.30 GHz

Cache 3 MB

RAM 2 GB

Serial Ports 2 RS-232 Serial Ports

USB Ports Two (2) USB 2.0 ports, front,
Five (5) USB 2.0 ports, rear
Three (3) Powered USB ports, 12V, rear

Keyboard Type PS/2

Mouse Type PS/2

Video Resolution 1280 x 1024 @ 16-bit color depth

Ethernet Connection 10/100/1000 Mbps Ethernet, RJ-45 connector

Expansion Slots PCI – Two (2) 4.2 inch height, 6.6 inch length, 25W
PCI Express x1 — One (1) 2.5 inch low profile, 6.6 inch length, 10W
PCI Express x16 — One (1) 2.5 inch low profile, 6.6 inch length, 25W
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Optical Drive DVD-R/DVD-RW capable

Hard Drive One (1) 250 GB SATA 3.0, 3.5 inch, internal

Voltage 120 VAC
220 VAC

Rated Line Frequency 50/60 Hz

Rated Power Consumption 110 VAC: 38.55 W (Operating), 2.65 W (Sleep), 0.93 W (Off)
220 VAC: 38.62 W (Operating), 2.90 W (Sleep), 1.12 W (Off)

Heat Dissipation 110 VAC: 132 BTU/hr (Operating), 9 BTU/hr (Sleep), 3 BTU/hr (Off)
220 VAC: 132 BTU/hr (Operating), 10 BTU/hr (Sleep), 4 BTU/hr (Off)

Dimensions (HxWxD) 3.95 in. x 13.30 in. x 14.90 in.
10.03 cm x 33.78 cm x 37.84 cm

Weight 15.06 lbs
6.84 kg

Operating Temperature 32° to 104° F
0° to 40° C

Operating Humidity 10% to 90%, non-condensing

Operating Atmospheric Pressure 10,000 feet
3,048 meters

Storage Temperature -22° to 149° F
-30° to 65° C

Storage Humidity 0% to 95%, non-condensing

Storage Atmospheric Pressure 30,000 feet
9,144 meters

Table 6. HP rp5800 Sall Form Factor (Continued)

Table 7. HP rp5700 Small Form Factor 

Processor

Type 1 Intel® Core 2 Duo (E6400e)

Speed 2.13 GHz
2MB L2 cache

Front Side Bus (FSB) 1066-MHz front side bus 

Memory 1GB PC2-5300 (DDR2-667)
Expandable to 4GB

Integrated I/O

Integrated Serial (2) RS-232C

Integrated USB (2) front USB 2.0 ports 
(4) rear USB 2.0 ports

Integrated Keyboard PS/2 standard keyboard supported
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Integrated Mouse PS/2 2-button optical scroll mouse

Video 1280x1024 @ 75 Hz
16 or 32 bit color

Integrated Ethernet 10/100/1000 NIC
RJ45 connector

Expansion Slots (PCI/ Cards) 3

Drive Bays

Optical Drive SATA 16X/48X DVD-ROM

Hard Drive 160GB SATA 3Gb/s

Power

Voltage 90 - 264 VAC, autoselecting

Rated Line Frequency 50/60 Hz

AC input connector IEC60-320 male connector.

Power consumption, rated Maximum Rated Power: 240 W

Heat dissipation (BTU/hr) 100 VAC: 215.297 BTU/hr
115 VAC: 214.614 BTU/hr 
230 VAC: 210.861 BTU/hr

Environmental

Operating Temperature +50° to +104° F
+10° to +40°C

Operating Humidity 20% to 85%, non-condensing at ambient

Operating Altitude 10,000 feet
3,048 meters

Storage Temperature -22° to +140°F
-30° to 60° C

Storage Humidity 5% to 90%, non-condensing at ambient

Storage Altitude 30,000 feet
9,144 meters

Physical

Size (HxWxD) 3.94 x 13.4 x 15 inches 
10 x 34 x 38 cm

Weight 19.4 lbs 
8.8 kg

Weight supported 77 lbs 
35 kg

Table 7. HP rp5700 Small Form Factor (Continued)
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Operating Systems

Operating Systems supported Microsoft Windows XP Professional US

Table 7. HP rp5700 Small Form Factor (Continued)

Table 8. 21-inch Sony Color Monitor CPD G520P 

CRT (cathode ray tube) 21 inches, FDTrinitron
90 -degree deflection

Viewable Image Size: 19.8" measured diagonally

Aperture Grille Pitch: 0.24mm 

Maximum Resolution: 2048 x 1536 @ 85Hz

Signal Inputs: Analog RGB: 0.7Vp-p, 75 ohm termination 
Sync Signal: Separate or composite sync: TTL 2k ohms, polarity free
Sync on Green: 0.3Vp-p, negative

AC input voltage/current 100-240V AC; 50-60Hz; 2.0-1.0 A

Power Consumption 135 W (approximate)

Dimensions (W x H x D): 19.75 x 19.5 x 19.2 inches

Weight: 66.2 lbs

Table 9. NEC MultiSync LCD 1850X 

LCD Module 18 inches,matrix, thin film transistor (TFT), liquid crystal display (LCD),0.28 mm dot pitch, 
XtraView+ technology, RGB vertical stripe color filter arrangement, 240 cd/m2 white 
luminance typical, 300:1 contrast ratio - typical

Active Display Area: Horizontal: 14.1 inches / 359 mm
Vertical: 11.3 inches / 287 mm
(Dependent upon signal timing used)

Current Rating 0.8A @ 100 - 120V / 0.4A @ 220 - 240V

AC input voltage/current Universal 100 (110-240V) 50-60Hz Internal

Power Consumption 65 W (Power Save Mode: 3W)

Viewing Angle Left/Right: 85°
Up: 85°
Down: 85°

Operating Temperature +41° F to +95° F / +5° C to +35° C

Operating Humidity Range 30% to 80%
A-8 MARS™ Holter Analysis System 2020044-065J



: 
     

Dimensions (W x H x D): Net (with stand):
15.7 in (W) x 17.5 in (H) x 8.6 in (D)
398 mm (W) x 452 mm (H) x 218 mm (D)

Net (without stand):
15.7 in (W) x 13.7 in (H) x 2.9 in (D)
398 mm (W) x 349 mm (H) x 74.4 mm (D)

Gross:
21.1 in. (W) x 21.6 in. (H) x 12.3 in. (D)
535 mm (W) x 548 mm (H) x 312 mm (D)

Weight: Net (with stand): 18.7 lbs. / 8.5 kg

Table 9. NEC MultiSync LCD 1850X (Continued)

Table 10. NEC MultiSync LCD 1980SX 

LCD Module 19-inch (19.0" viewable image size), active matrix, thin film transistor (TFT), liquid crystal 
display (LCD),0.294 mm dot pitch, XtraView+ technology, RGB vertical stripe color filter 
arrangement, 250 cd/m2 white luminance typical, 600:1 contrast ratio - typical, 25ms 
response time - typical 

Active Display Area Horizontal: 15.0 inches / 380 mm
Vertical: 11.8 inches / 300 mm
(Dependent upon signal timing used) 

Current Rating 0.7A @ 100 - 120V / 0.35A @ 220 - 240V (without Option soundbar)
0.8A @ 100 - 120V / 0.45A @ 220 - 240V (with Option soundbar) 

AC input voltage/current Universal 100 (110-240V) 50-60Hz Internal

Power Consumption 36 W (Power Save Mode: <1W)

Viewing Angle Left/Right: 85°
Up: 85°
Down: 85° 

Operating Temperature +41° F to +95° F / +5° C to +35° C

Operating Humidity Range 30% to 80%

Dimensions (W x H x D) Net (with stand):
16.2 x 14.4-19.5 x 7.9 inches
412.2 x 364.8-494.8mm x 200mm millimeters

Net (without stand):
16.2 x 13.3 x 3.1 inches
412.2 x 337 x 80 millimeters

Weight Net (with stand): 20.5 lbs. / 9.3kg
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Table 11. NEC MultiSync LCD 1990SXi 

Display

Viewable Size Image 19"

Pixel Pitch 0.294mm

Pixels Per Inch 86 @ native resolution

Brightness (typical) 270 cd/m2

Contrast Ratio (typical) 600:1

Viewing Angle (typical) 178° Vert., 178° Hor. (89U/89D/89L/89R)@ CR>10

Response Time (typical) Rapid Response (18ms)

Display Colors 16.7 million out of 68.5 billion

Synchronization Range

Horizontal 31.5-81.1 KHz (Analog/Digital)

Vertical 50-85 Hz

Input Signal

Video ANALOG RGB 0.7 Vp-p / 75 Ohms

Sync Separate sync: TTL Level (Positive/Negative)
Composite sync: TTL Level (Positive/Negative)
Composite sync on green: (0.3Vp-p negative
0.7Vp-p positive)

Input DVI-D, DVI-I & VGA 15 pin D-sub

Resolutions Supported ANALOG/DIGITAL
640 x 400 @ 70-85 Hz
720 x 400 @ 70-85 Hz
640 x 480 @ 60-85 Hz
800 x 600 @ 56-85 Hz
832 x 624 @ 75 Hz
1024 x 768 @ 60-85 Hz
1152 x 864 @ 70-85 Hz
1152 x 870 @ 75 Hz
1280 x 960 @ 60 Hz
1280 x 1024 @ 60-75 Hz

Native Resolution 1280 x 1024 @ 60 Hz

Additional Features Ultra-thin-frame (bezel), No Touch Auto Adjust,
NaViSet software, tilt, VESA mount, sRGB, cable
management, touch-enabled, swivel, vacation
switch, height-adjustable stand, 12-bit gamma,
AmbiBright, pivot, ColorComp, overdrive,
eco-mode, real-time clock, quick release stand,
Ambix
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Touch-Capable Designed for integration

Voltage Rating AC 100-120V / AC 220-240V

Power Consumption (typical)

On 52W

Power Savings Mode <1W

Dimensions (WxHxD)

Net (with stand) 15.8 x 14.4-19.5 x 9.7 in./402.3 x 410.7-560.7 x 247.3mm

Net (without stand) 15.8 x 13 x 3.1 in./402.3 x 330.3 x 80mm

Net Weight

(with stand) 19.8 lbs./9 kg

(without stand) 13.8 lbs./6.3 kg

VESA Hole Configuration Specifications 100 x 100mm

Environmental Conditions

Operating Temperature 5-35° C/41-95° F

Operating Humidity 30-80%

Operating Altitude 3048m/10,000 ft.

Storage Temperature -10-60° C/14-140° F

Storage Humidity 10-85%

Storage Altitude 12,192m/40,000 ft.

Table 11. NEC MultiSync LCD 1990SXi (Continued)

Table 12. Compaq 17-inch Color Monitor (V720) 

CRT size: 17-inch High-contrast Flat Faceplate

Viewable Image Size: 16" viewable

Horizontal Dot Pitch .20 -.25 mm

Digital Dot Pitch .25 -.28 mm

Max Resolution 1600 Dots x 1200 Lines 

Text Mode 720 x 400/ 70 Hz

Horizontal Frequency 30 - 86 KHz

Vertical Frequency 50 - 160 KHz

Maximum Power Rating 100 W

Synch Input TTL separate synch

Signal Cable Captive 15-pin D-sub video cable
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Dimensions (W x D x H) 15.66 x 16.22 x 15.74 inch (398 x 412 x 400 mm)

Weight 35.7 lb. (16.2 kg)

Power Consumption 100 W maximum

Power Saver State < 3 W

Operating Temperature 32°F-104°F (0°C - 40°C)

Operating Humidity 20%-80% (Non-Condensing)

Table 12. Compaq 17-inch Color Monitor (V720) (Continued)

Table 13. HP 19-inch LCD Monitors  

Specification HP LE1911 19_inch LCD Monitor HP L1910 19-inch LCD Monitor 

LCD Module 19-inch active matrix TFT (thin film 
transistor )

19-inch active matrix TFT (thin film 
transistor )

Viewable Image Area 19 inches (48.26 cm) diagonal 19 inches (48.26 cm) diagonal

Active Display Area Horizontal: 14.8 inches / 37.8 cm
Vertical: 11.9 inches / 30.3 cm

Horizontal: 14.8 inches / 37.8 cm
Vertical: 11.9 inches / 30.3 cm

Viewing Angle 160° horizontal
160° vertical
10:1 minimum contrast ratio

160° horizontal
160° vertical
10:1 minimum contrast ratio

Brightness 250 nits (cd.m2) 300 nits (cd.m2)

Contrast Ratio 1000:1 800:1

Response Rate 5 ms (rise and fall 5 ms (rise and fall)

Pixel Pitch 0.294 mm 0.294 mm

Backlight Lamp Life 50 K hours 50 K hours

Horizontal Frequency 24 to 83 kHz 24 to 83 kHz

Vertical Frequency 50 to 70 Hz 50 to 70 Hz

Native Resolution 1280 x 1024 @ 60 Hz 1280 x 1024 @ 60 Hz

Current < 0.50 Ampere < 0.50 Ampere

AC input voltage/current Universal 100 (110-240V) 50-60Hz Internal Universal 100 (110-240V) 50-60Hz Internal

Power Consumption Maximum: < 28 watts
Typical: 24watts
Power Save Mode: <2 watts

Maximum: < 38 watts
Typical: 31 watts
Power Save Mode: <2 watts

Operating Temperature +41° to +95° F (+5° to +35° C), non-
condensing

+41° to +95° F (+5° to +35° C), non-
condensing

Operating Humidity Range 20% to 80%, non-condensing 20% to 80%, non-condensing
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Dimensions (W x H x D) With stand: 16.4 x 16.3 x 8.1 in / 41.6 x 
41.4 x 20.6 cm
Head only: 13.7 x 16.3 x 2.3 in / 34.7 x 41.4 
x 5.8 cm

With stand: 16.4 x 16.3 x 7.6 in / 41.6 x 
41.4 x 19.2 cm
Head only: 13.7 x 16.3 x 2.3 in / 34.7 x 41.4 
x 5.8 cm

Weight Head only: 9.0 lbs. / 4.1 kg Head only: 8.6 lbs. / 3.9 kg

Table 13. HP 19-inch LCD Monitors  (Continued)

Table 14. Card Reader Unit (internal) 

Type Omni Drive Professional

Pc Card Slots 1 Type lll slot, front side

Interface Centronics interface (printer port) SPP, EPP automatic configuration

Data Transfer Speed up to 1 mbyte/sec

Types of PC Card SRAM Linear flash ATA/flash hard disk type ll, lll

Weight 1.32 lbs. or 600 g

Operating temperature 0 C to +70 C

Storage Temperature -20 C to +85 C

Humidity max. 90%, non-condensing

Power Supply 5 V DC from PC via keyboard adapter

Table 15. Card Reader Unit (external) 

Type Omni Drive USB

PC Card Slots 1x Type ll front slot

Interface USB 1.1 (12 MBit/s)

Data Transfer Speed up to 1 MByte/sec

Types of PC Card SRAM; ATA Flash, ATA Hard Disk; CompactFlash, SmartMedia, MultiMedia, Secure 
Digital cards, a.o. with adapter

Dimensions 109 mm x 35 mm x 135 mm

Weight approx. 300 g

Operating temperature 0 C to +70 C

Storage Temperature -20 C to +85 C

Humidity max. 90%, non-condensing

Power Supply DC 5 V from PC via USB bus optional additional power supply via AC adapter
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Table 16. SEER Tape Acquisition 

Type GE Medical Systems Information Technologies Tape Acquisition Unit

Nominal Voltage Range 100-120 VAC or 200-240 VAC (auto sensing)

Nominal Frequencies 50 Hz or 60 Hz (auto sensing)

Maximum Power Consumption 55 Watts

Processor DSP56002 microprocessor

Processor Clock Speed 66 MHz

Tape Drive Braemer CD350 Holter playpack tape drive

Media

Cassette Tape C-60 or C-120 cassette tapes

Interface Ports One SCSI

Channels 1 or 2 (user selectable) and clock track

Resolution 12 bits

Sampling Frequency 128 samples/sec (real time)

Playback Speed

Cassette 1000 times real time

Frequency Response 0.66 to 50 Hz overall (recorder to system)

Phase Response Linear, less than 6 degrees phase shift at 0.5 Hz

Tape Playback Options The tape is played back at approximately 1000 times real time. Analog amplifiers with gain 
and phase equalization optimized for Holter tape processing are provided for all channels. 
Tape speed variations are compensated by a time warp filter circuit synchronized to the 
clock track on the tape.

Effective Sampling Rates

8500 Cassette, 1 mm/sec; phase-locked, 128 samples/sec

Physical Specifications

Height 2.8 in (7.1 cm)

Width 9.6 in (24.4 cm)

Depth 10.4 in (26.4 cm)

Weight 5.1 lb (2.3 kg)

Table 17. Hewlett Packard 1200 LaserJet Printer 

Speed 15 ppm

Resolution 1200 dpi

Duty Cycle 10,000 single sided pages per month
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Power Consumption

Printing 285 watts average

Standby Mode and Power Save 7 watts

Power Requirements  110-120 v (+/-10%), 50-60 Hz (+/-2); 127V, 60 Hz 
or
 220v (+/-10%), 50-60 Hz (+/-2)
 220-240v (+/-10%), 50 Hz (+/-2)

Dimensions (h x w x d) 10.0 x 16.3 x 19.1 in. (25.3 x 41.5 x 48.6 cm)

Weight 16.1 lbs. (7.3 kg)

Table 17. Hewlett Packard 1200 LaserJet Printer (Continued)

Table 18. Hewlett Packard 4200N LaserJet Printer 

Speed 35 ppm letter size 

Resolution 1200 dpi

Memory, Standard 48 MB

Memory, Maximum 416 MB

First page out <9 sec.

Power requirements 110-127 v (50-60 Hz) /220-240 v (50-60 Hz)

Operating Temperature 50-90  F (10-32  C)

Dimensions (h x w x d) 16.2 x 41.1 x 21.5 in. (412 mm x 1045 mm x 547 mm)

Weight 45.0 lbs. (20.0 kg)

Table 19. Hewlett Packard 4250N LaserJet Printer 

Speed 45 ppm letter size 

Resolution 1200 dpi

Memory, Standard 48 MB

Memory, Maximum 512 MB

First page out <8 sec.

Power requirements 110-127 v (50-60 Hz) /220-240 v (50-60 Hz)

Operating Temperature 50-90  F (10-32  C)

Dimensions (h x w x d) 16.5 x 17.8 x 14.8 in. (418 mm x 451mm x 498 mm)

Weight 45.0 lbs. (20.0 kg)
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Table 20. Powerware PW5115 500 UPS, 120 volt 

Dimensions (W x H x D) 15.0 x19.3 x 27.0 cm (5.9 x 7.6 x 10.6 inches)

Weight 7.8 kg (17.2 lbs)

Electrical Input

Nominal Voltage 110v, 120v selectable

Voltage Range +/-20% for nominal voltage at full load

Nominal Frequency 45-65 Hz, 50/60 Hz auto-sensing

Efficiency (normal mode) 95%

Overcurrent Protection Resettable input overcurrent protector

Electrical Output

Power Levels 500 VA, 320W

Power Factor 500 VA, 0.64

Regulation(Battery Mode), Nominal voltage 
+/-5%

110v, 120v

Regulation (Normal Mode) -10% to 6% of nominal voltage

Voltage waveform Sine Wave

Overcurrent Protection Inverter saturation current limited

Battery

Voltage 500VA: 12Vdc

Type Sealed, maintenance-free, valve-regulated, lead-acid

Table 21.  ONEAC PCm750J—C4CB VA Medical Grade Power Conditioner

Dimensions (WxHxD) 6.4 x 5.4 x 10.9 inches
16.4 x 13.7 x 27.7 centimeters

Weight 12 pounds
26.5 kilograms

Load 750 VA

Frequency 50/60 Hz

Input/Output Connectors IEC320 / (4) IEC320

Nominal Input/Output Rating 100 — 200 V

Output Current 6.2 amps
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Table 22.  ONEAC PCm750I—C4CB VA Medical Grade Power Conditioner

Dimensions (WxHxD) 6.4 x 5.4 x 10.9 inches
16.4 x 13.7 x 27.7 centimeters

Weight 14.5 pounds
32 kilograms

Load 750 VA

Frequency 50/60 Hz

Input/Output Connectors IEC320 / (4) IEC320

Nominal Input/Output Rating 200 — 240 V

Output Current 3.1 amps

Table 23.  Powervar ABC600-11MED Medical Grade Power Conditioner

Dimensions (WxHxD) 8.10 x 4.29 x 11.80 inches
20.57 x 10.90 x 29.97 centimeters

Weight 23.00 pounds
10.43 kilograms

Load 720 VA

Frequency 60 Hz

Input/Output Connectors IEC320 / (6) IEC320

Nominal Input/Output Rating 120 VAC

Output Current 6 amps

Table 24.  Powervar ABC750-22MED Medical Grade Power Conditioner

Dimensions (WxHxD) 8.11 x 4.29 x 11.81 inches
20.6 x 10.90 x 30 centimeters

Weight 28.66 pounds
13.00 kilograms

Load 750 VA

Frequency 50/60 Hz

Input/Output Connectors IEC320 / (6) IEC320

Nominal Input/Output Rating 200 — 264 VAC

Output Current N/A. The output power is rated in VA.
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Table 25. Ricoh SP4100N 

PPM BW (LT) 31

First Print Speed BS 6.9 sec

Warm-up Time 19 sec

CPU 400MHz

Memory (Std./Max.) 128MB/384MB

Resolution (Max.) 1200 x 600 dpi
600 x 600 dpi

Printer Languages RPCS, PCL5C, PCL-6, PS3/PDF

Duplex Option

Interface (Std.) 10.100 Base-TX, USB 2.0, IEEE1284

Input Capacity (Std./Max.) 600/1600

Output Capacity (Std.) 250

Paper Weight from Std. Tray 16–34lb

W x D x H 15.3 x 17.8 x 13.6 (inches)

Table 26. HP LaserJet P4015 Printer

Speed 52 ppm 

Resolution 1200 x 1200 dpi

Memory, Standard 128 MB

Memory, Maximum 640 MB

First page out <9 sec.

Power requirements 100-127 V (50-60 Hz) 
220-240 V (50-60 Hz)

Power Consumption 840 watts active
18 watts ready
12 watts sleep mode
0 watts off

Operating Temperature 50 - 90 F 
10 - 32 C

Storage Temperature 32 - 95 F
0 - 35 C
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Dimensions (h x w x d) 16.5 x 17.7 x 15.5 in. 
41.91 x 44.95 x 39.37 cm

Weight 59.92 lbs. 
27.2 kg

Table 26. HP LaserJet P4015 Printer

Table 27. Powerware PW5115 500i UPS, 230 volt  

Dimensions (W x H x D) 15.0 x19.3 x 27.0 cm (5.9 x 7.6 x 10.6 inches)

Weight 7.8 kg (17.2 lbs)

Electrical Input

Nominal Voltage 220v, 230v, 240v selectable

Voltage Range +/-20% for nominal voltage at full load

Nominal Frequency 45-65 Hz, 50/60 Hz auto-sensing

Efficiency (normal mode) 95%

Overcurrent Protection Resettable input overcurrent protector

Electrical Output

Power Levels 500 VA, 320W

Power Factor 500 VA, 0.64

Regulation(Battery Mode), Nominal voltage 
+/-5%

220v, 230v, 240v

Regulation (Normal Mode) -10% to 6% of nominal voltage

Voltage waveform Sine Wave

Overcurrent Protection Inverter saturation current limited

Battery

Voltage 500VA: 12Vdc

Type Sealed, maintenance-free, valve-regulated, lead-acid

Table 28. Oneac PCmSeries 500 – 1000 VA Medical Grade Isolation Transformer 

Dimensions (W x H x D) 16.4 x 13.7 x 27.7 cm (6.4 x 5.4 x 10.9 inches)

Weight
 PCM750J-C4CB
 PCM750I-C4CB

 
13.6 kg (30 lbs)
11.3 kg (25 lbs)

Load 750 VA
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Nominal Input/Output Rating
 PCM750J-C4CB
 PCM750I-C4CB

100 – 120 V
200 – 240 V

Output Current
 PCM750J-C4CB
 PCM750I-C4CB

6.2 Amps
3.1 Amps

Frequency 50/60 Hz

Input/Output Connectors IEC320/ (4) IEC 320

Table 28. Oneac PCmSeries 500 – 1000 VA Medical Grade Isolation Transformer (Continued)

Table 29. SEER Light Connect Device 

Dimensions Height: 13 mm (.51 in)
Width: 90 mm (3.54 in)
Depth: 51 mm (2.01 in)
Cable length: 260 mm (10.24 in)

Weight 87 g (.19 lbs) 

Operating temperature 10 to 35°C (50 to 95°F)

Operating humidity 10 to 95% relative humidity (no condensation allowed)

Storage temperature –20 to 65°C (-4 to 149°F)

Storage humidity 5 to 90% relative humidity (no condensation allowed)

Power supply DC 5V

Recorders SEER Light Recorder
SEER Light Extend Recorder

Table 30. Environmental, System-Wide 

Power 15 amps

Operating Conditions

Temperature 10 to 35º C (50 to 90º F)

Relative Humidity 20% to 80%

Maximum Altitude 2,500 meters (8,200 feet)

Storage/Transport Conditions

Temperature -20 to 43 degrees C (-40 to 110 degrees F)

Relative Humidity 8% to 80%

Maximum Altitude 10,350 meters (34,000 feet)
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Table 31. Safety 

Certification UL listed
CSA certified
TUV certified
EN 60950 (UL 1950)
CE marking for Council Directive 93/42/EEC

Type of Protection Against Electrical Shock Class 1

Degree of Protection Against Ingress of 
Liquids

Ordinary

Handling of Disposable Supplies and Other 
Consumables

 Use only parts and accessories manufactured or recommended by GE Healthcare.
 Follow manufacturer’s instructions for use for disposable/consumable product.
 Follow local environmental guidelines concerning the disposal of hazardous materials 

(e.g. lead acid batteries).

Patient Mode of Operation Continuous

Patient Leakage Current Not applicable

Degree of Protection Against Electrical 
Shock

Not applicable

Maintenance Frequency  Recommended user daily visual inspection and cleaning.
 Recommended six-month routine maintenance checks and test procedures 

performed by qualified technical personnel.

Repair Guidelines Calibration instructions, equipment descriptions, and all other service information to 
repair those parts of the equipment designated as field repairable by qualified technical 
personnel is available in the service manual.

Table 27. Multi-Tech MT9234ZBA Modem 

Manufacturer/Model Multi-Tech MT9234ZBA 

Server-to-Client Data Rates 56K speeds when accessing a V.90 or V.92 server (actual speed depends on server 
capabilities and line conditions)

Client-to-Server Data Rates Up to 48Kbps when accessing a V.92 server (actual speed depends on server capabilities 
and line conditions); otherwise the same as client-to-client data rates (see next listing).

Client-to-Client Data Rates 33600, 31200, 28800, 26400, 24000, 21600, 19200, 16800 bps, 14400, 12000, 9600, 
7200, 4800, 2400, 1200, 0-300 bps

Fax Data Rates 33600, 31200, 28800, 26400, 24000, 21600, 19200, 16800

Voice Compatibility TIA/EIA IS-101 (Voice Option only)

Data Format Serial, binary, asynchronous

Modem Compatibility ITU-T V.92, V.90, V.34 enhanced, V.34, V.32bis, V.32, V.22bis, V.22; Bell 212A and 103/
113; ITU-T V.21 & V.23; V.42, V.42bis, V.44.

Fax Compatibility ITU-T “Super” Group 3; Class 1.0, 2.0, 2.1; T.4; T.30; V.21; V.27ter; V.29; V.34; V.17; and 
TIA/EIA Class 1, 2; TR29.2
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Video Compatibility ITU-T V.80 for H.324 video conferencing

Error Correction ITU-T V.42 

Data Compression ITU-T V.44 (6:1 throughput)

Speed Conversion Serial port data rates adjustable to 300, 1200, 2400, 4800, 9600, 19,200, 38,400, 57,600, 
115,200, and 230,400 bps

Mode of Operation Fax online modes; full duplex over dial-up lines; 

Flow Control XON/XOFF (software), RTS/CTS (hardware)

Intelligent Features Plug and play; fully AT command compatible; dialing options, autoanswer; adaptive 
answer; EIA extended automode; adaptive line probing; automatic symbol and carrier 
frequency during start-up, retrain, and rate renegotiation; DTMF detection; call status 
display, auto-parity and data rate selections; keyboard-controlled modem options; non-
volatile memory; remote configuration; DTR dialing; callback security; A-law support in 56K 
modes; 11-bit support; realtime fax compression conversion; U.S. Caller ID reporting; 
quick-connect startup(V.92).

Command Buffer 40 characters

Transmit Level -12 dBm (Eruo/NAM) – varies by country/region setting

Frequency Stability ±0.01%

Receiver Sensitivity -43 dBm under worst-case conditions

AGC Dynamic Range 43 dB

Interface TIA/EIA RS-232C/ITU-T V.24/V.28

Connectors DB25F RS-232C connector; 2 RJ-11 telephone jacks; power jack

Cables Country-specific telephone; power cables; serial cable
Note:  Any cables connected to the computer should be shielded to reduce interference.

Diagnostics Power-on self test, local analog loop, local digital loop, remote digital loop.

Indicators LEDs for Transmit Data, Receive Data, Carrier Detect, 56K bps, 33.6K bps, 14.4K bps, Off 
Hook, Terminal Ready, Error Correction, Fax.

Speaker Internal speaker for call progress monitoring.

Manual Control Power switch

Operating Temperature -40°– 60°C (-40°–140°F) ambient under closed conditions; humidity range 20–90% (non-
condensing)

Power Requirements Global modems: 100–240 VAC, 50/60 Hz universal power supply
Non-global modems: 115 VAC, 60 Hz or 230 VAC, 50 Hz power supply

Power Consumption 9 VDC, 300 mA maximum 

Dimensions 10.8 cm wide × 14.8 cm long × 2.9 cm high (4.25 in× 5.8 in× 1.15 in)

Weight 224 g (8 oz)

Limited Warranty 10 years

Table 27. Multi-Tech MT9234ZBA Modem (Continued)
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: Slot Installation/Time Consumption Report
Slot Installation/Time Consumption Report

As shown in the following tables, increasing the number of patient slots can 
result in increased installation time and decreased system performance. Be 
aware of this when configuring your system. 

The following results are based on a Compaq EVO D510 platform, which 
has a 2.8 GHz processor, 256 MB RAM, and the Windows 2000 
Professional operating system. Performance may vary greatly depending on 
hardware type, network speed, operating system, and other factors. 

By default, each SEER slot file takes 57 MB and each tape slot file takes 83 
MB. These sizes may increase if you use the Slot File tool.

Standalone System Slot Install Time Duration and Performance Considerations

Client-Server Slot Install Time Duration and Performance Considerations 

Slot Installation Performance Impact

Hardware 
Number of SEER 

Slots Installed
Number of Tape 
Slots Installed

Installation Time
Start MARS 
Application

Start Patient 
Select

Start Function 
(Strip Review) 

D510 with Win2k 
Pro

50 0 7 min 45 sec <1 sec <1 sec <1 sec 

D510 with Win2k 
Pro

100 50 14 min 35 sec 1 sec 1 sec <1 sec 

D510 with Win2k 
Pro

500 100 35 min 1.5 sec 8 sec 1 sec 

D510 with Win2k 
Pro

900 100 51 min 2 sec 17 sec 1 sec

Slot Installation Performance Impact

Hardware 
Number of 
SEER Slots 

Installed

Number of 
Tape Slots 
Installed

Installation 
Time

Network Speed
Start MARS 
Application 
from Client

Start Patient 
Select from 

Client

Start Function 
(Strip Review) 

from Client
D510 with 

Win2k Server
100 50 27 min 100 Mb per sec 1 sec 2 sec 1 sec

D510 with 
Win2k Server

100 50 27 min 10 MB per sec 1 sec 2 sec 1 sec

D510 with 
Win2k Server

500 100 71 min 100 MB per sec 1 sec 9 sec 1 sec

D510 with 
Win2k Server

500 100 71 min 10 MB per sec 1 sec 10 sec 1 sec
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: Electromagnetic Compatibility (EMC)
Electromagnetic Compatibility (EMC)

Changes or modifications to this system not expressly approved by General Electric can 
cause EMC issues with this or other equipment. This system is designed and tested to 
comply with applicable regulation regarding EMC and must be installed and put into service 
according to the EMC information stated in this appendix.

WARNING
Use of portable phones or other radio frequency (RF) emitting equipment 
near the system may cause unexpected or adverse operation.

WARNING
The equipment or system should not be used adjacent to, or stacked 
with, other equipment. If adjacent or stacked use is necessary, the 
equipment or system should be tested to verify normal operation in the 
configuration in which it is being used.
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: Electromagnetic Emissions
Electromagnetic Emissions

Guidance and manufacturer’s declaration – electromagnetic emissions

The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is intended for use in the electromagnetic environment 
specified below. The customer or user of the MARS HOLTER ANALYSYS WORKSTATION SYSTEM should 
assure that it is used in such an environment.
Emissions Test Compliance Electromagnetic Environment – guidance
RF emissions (Radiated)
30 MHz to 1,000 MHz
IEC 60601-1-2:2004
CISPR22:1997 / A1:2000 / A2:2002

EN 55022:1998 / A1:2000 / A2:2003

30 MHz to 5 GHz
FCC 47CFR Part 15.33
FCC 47CFR Part 15.109

Group 1
Class B

The MARS HOLTER ANALYSYS WORKSTATION SYSTEM uses RF energy 
only for its internal function. Therefore, its RF emissions are very low and are not likely 
to cause any interference in nearby electronic equipment.

The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is suitable for use 
in all establishments, including domestic establishments and those directly connected 

to the public low-voltage power supply network that supplies buildings used for 
domestic purposes.

RF emissions 
(Conducted)
150 KHz to 30 MHz
IEC 60601-1-2:2004
CISPR22:1997 / A1:2000 / A2:2002

EN 55022:1998 / A1:2000 
/ A2:2003
150 KHz to 30 MHz
FCC 47CFR Part 15.107

Group 1
Class B

Harmonic Emissions

2nd – 40th Harmonic
IEC 60601-1-2:2004
EN 61000-3-2:2000 / A1:2001

Class D The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is suitable for use 
in all establishments, including domestic establishments and those directly connected 

to the public low-voltage power supply network that supplies buildings used for 
domestic purposes.

Voltage fluctuations/
Flicker emissions
IEC 60601-1-2:2004
EN 61000-3-3:1995 / A1:2002

Complies
Pass
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Electromagnetic Immunity

Guidance and manufacturer’s declaration – electromagnetic immunity
The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is intended for use in the electromagnetic environment 
specified below. The customer or user of the MARS HOLTER ANALYSYS WORKSTATION SYSTEM should assure 
that it is used in such an environment.

Immunity Test Compliance
Test level

Compliance level Electromagnetic environment – guidance

Electrostatic 
discharge (ESD) 
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-2:1995 / 
A1:1998 / A2:2001

± 2/4 kV indirect
± 2/4 kV direct
± 2/4/8 kV air

± 4 kV indirect
± 4 kV direct
± 8 kV air

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%.

Electrical fast 
transient/burst (EFT)
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-4:1995 / 
A1:2001

± 1 kV for power 
supply lines
±500V for input/
output lines

± 1 kV for power 
supply lines
±500V for input/
output lines

Mains power should be that of a typical 
commercial or hospital environment.

Fast Transient Surge 
(FTS)
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-5:1995 / 
A1:2001

± 500V/1 kV 
differential mode
± 2 kV common 
mode

± 1 kV differential 
mode
± 2 kV common 
mode

Mains power should be that of a typical 
commercial or hospital environment.

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input 
lines
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-11:1994 / 
A1:2001

<5% Ut (>95% dip in Ut) for 
0.5 cycles

<40% Ut (>60% dip in Ut) for 
5 cycles

<70% Ut (>30% dip in Ut) for 
25 cycles

<5% Ut (>95% dip in Ut) for 
5 s

<5% Ut (>95% dip in Ut) for 
0.5 cycles

<40% Ut (>60% dip in Ut) for 
5 cycles

<70% Ut (>30% dip in Ut) for 
25 cycles

<5% Ut (>95% dip in Ut) for 
5 s

Mains power should be that of a typical 
commercial or hospital environment. If the 
user requires continued operation during 
power mains interruptions, it is 
recommended that power be supplied from 
an applicably rated uninterruptible power 
supply or a battery.
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Power frequency (50/60 
Hz) magnetic field

IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-8:1993 / 
A1:2001

3 A/m 3 A/m Power frequency magnetic fields should be 
at levels characteristics of a typical location 
in a typical commercial or hospital 
environment.

NOTE: Ut is the a.c. mains voltage prior to application of the test level.
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Electromagnetic Immunity

Guidance and manufacturer’s declaration – electromagnetic immunity
The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is intended for use in the electromagnetic environment specified below. The 
customer or user of the MARS HOLTER ANALYSYS WORKSTATION SYSTEM should assure that it is used in such an environment.

Immunity Test Compliance
Test level

Compliance 
level

Electromagnetic environment – guidance

Portable and mobile RF communications equipment should be 
used on closer to any part of the MARS PC SYSTEM, including 
cables, than the recommended separation distance calculated 
fro the equation applicable to the frequency of the transmitter.
Recommended separation distance

Conducted RF
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-6:1996 / 
A1:2001

3 Vrms
150 KHz to 80 MHz
@ 1 KHz mod.

3 V rms
d = 1.17

Radiated RF
IEC 60601-1-2:2004
EN 55024:1998 / 
A1:2001 / A2:2003
EN 61000-4-3:2002 / 
A1:2002

3 V/m
80 MHz to 1,000 MHz
@ 1 KHz mod.

3 V/m
d = 1.17  80 MHz to 800 MHz

d = 2.33  800 MHz to 1.0 GHz

where P is the maximum output power rating of 
the transmitter in watts (W) according to the 
transmitter manufacturer and d is the 
recommended separation distance in meters 
(m).

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey a, 
should be less than the compliance level in each 

frequency range. b

Interference may occur in the vicinity of equipment marked with 
the following symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by reflection from 
structures, objects, and people.

P

P

P
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a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and 
land mobile radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with 
accuracy. To assess the electromagnetic environment due to fixed RF transmitters, and electromagnetic site 
survey should be considered. If the measured field strength in the location in which the MARS PC SYSTEM 
is used exceeds the applicable RF compliance level above, the MARS PC SYSTEM should be observed to 
verify normal operation. If abnormal performance is observed, additional measures may be necessary, such 
as re-orienting or relocating the MARS PC SYSTEM

b Over the frequency range 150 KHz to 80 MHz, field strengths should be less than 3 V/m.
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Separation Distance

Recommended separation distances between
 portable and mobile RF communications equipment and the MARS HOLTER ANALYSYS SYSTEM

The MARS HOLTER ANALYSYS WORKSTATION SYSTEM is intended for use in the electromagnetic environment on which radiated RF 
disturbances are controlled. The customer or the user of the MARS HOLTER ANALYSYS WORKSTATION SYSTEM can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the MARS HOLTER ANALYSYS WORKSTATION SYSTEM as recommended below, according to the maximum output 
power of the communications equipment. 

Rated maximum output 
power of transmitter

W

Separation distance (meters) according to frequency of transmitter

150 kHz to 80 MHz

d = 1.17

80 MHz to 800 MHz

d = 1.17

800 MHz to 1.0 GHz

d = 2.33

0.01 0.12 0.12 0.23

0.1 0.37 0.37 0.74

1 1.17 1.17 2.33

10 3.70 3.70 7.37

100 11.7 11.7 23.3

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can estimated using the 
equitation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (w) according to the 
transmitter manufacturer.

NOTE 1    At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2   These guidelines may not apply in all instances. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects and people.

P P P
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EMC Exceptions(s) Disclosure

EMC Exception(s) Disclosure

Type Exception
Electromagnetic 

Environment 
Guidance

Electrostatic discharge (ESD) No exceptions NA

Electrical fast transient/burst (EFT) No exceptions NA

Fast Transient Surge (FTS) No exceptions NA

Voltage dips, short interruptions and 
voltage variations on power supply 
input lines

No exceptions NA

Power frequency (50/60 Hz) 
magnetic field

No exceptions NA

Conducted RF No exceptions NA

Radiated RF No exceptions NA
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Compliant Cables and Accessories

WARNING
The use of accessories, transducers and cables other than those 
specified may result in increased emissions or decreased immunity 
performance of the equipment or system.

The table below lists cables, transducers, and other applicable accessories with which GE 
Healthcare claims EMC compliance.

NOTE
Any supplied accessories that do not affect EMC compliance are not included.

Part No Description
Maximum Cable / Cord 

Lengths

2030979-001 19" LCD monitor, NEC MultiSync model 1990Sxi (includes DVI-A        to 15-pin 
VGA cable)

1.8 m / 6 ft

2040982-001 19” LCD monitor, HP LE1911 or HP L1910 (includes VGA cable) 1.8 m / 6 ft

2025143-001 Network printer, HP LaserJet 4250n N/A

2044121-001 Network printer, HP LaserJet 4015n N/A

2018217-001 RJ45 Crossover CAT5 Cable for HP Laser Jet 4250n and P4015n printers 7.6 m / 25 ft

2016193-001 USB Keyboard N/A

334684-002 Hewlett-Packard PS/2 mouse (2 button w/scroll) N/A

2025508-001 Omni Drive USB Professional Linear Flash Unit; includes USB cable 1.9 m / 6.5 ft

900466-003 Tape Acquisition Unit N/A

2030414–001 ONEAC Medical Grade Isolation Transformer 120 VAC N/A

Powervar Medical Grade Power Conditioner 120 VAC

2030141–002 ONEAC Medical Grade Isolation Transformer 220 VAC N/A

Powervar Medical Grade Power Conditioner 200–264 VAC

2005410-001 Tape Acquisition Unit SCSI-1 cable 1.5 m / 5 ft

2026470-002 Oneac Medical Grade Power Conditioned UPS 120 VAC N/A

2026470-003 Oneac Medical Grade Power Conditioned UPS 230 VAC N/A

N/A IEC320 male to female cord supplied with Oneac Medical Grade Power 
Conditioned UPS

1.8 m / 6 ft

N/A Serial Cable supplied with Oneac Medical Grade Power Conditioned UPS 3.0 m / 10 ft

405535-002 Hospital Grade AC Power Cord 3.6 m / 12 ft 

2003927-001 IEC320 male to female Cord 2.4 m / 8 ft 
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2008595-009 SEER Light Connect with USB interface, includes USB cable supplied with 
SEER Light Connect

1.8 m / 6 ft

2008595-007 SEER Light Compact Digital Holter Recorder, 48 hour, 64MB N/A

Part No Description
Maximum Cable / Cord 

Lengths
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